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This	help	file	contains	information	on	configuring	and	testing	DAQ	and
SCXI	products	using	Measurement	&	Automation	Explorer	(MAX)	for
Traditional	NI-DAQ	(Legacy),	and	information	on	special	considerations
for	operating	systems.

Caution		Traditional	NI-DAQ	(Legacy)	is	an	older	driver	with	outdated	application	programming
interfaces	(APIs)	for	developing	data	acquisition,	instrumentation,	and	control	applications	for
older	National	Instruments	DAQ	devices.	You	should	use	Traditional	NI-DAQ	(Legacy)	only	in
certain	circumstances.	Refer	to	the	NI-DAQ	Readme	for	more	information	about	when	to	use
Traditional	NI-DAQ	(Legacy),	including	a	complete	list	of	supported	devices,	operating	systems,
application	software	versions,	and	language	versions.	Refer	to	the	NI-DAQmx	Help,	which	you
can	access	from	Start»Programs»	National	Instruments»NI-DAQ»NI-DAQmx	Help,	for	an
overview	of	the	two	NI-DAQ	APIs	and	the	advantages	of	NI-DAQmx.	In	NI	application	software,
this	same	help	is	available	by	searching	for	NI-DAQmx.	You	can	install	the	latest	version	of	NI-
DAQmx	software,	available	at	ni.com/downloads.

To	navigate	this	help	file,	use	the	Contents,	Search,	and	Index	tabs	to
the	left	of	this	window.
For	more	information	about	this	help	file,	refer	to	the	following	topics:
Conventions—formatting	and	typographical	conventions	in	this	help	file
Related	Documentation
Glossary
Important	Information
Technical	Support	and	Professional	Services
To	comment	on	National	Instruments	documentation,	refer	to	the	National
Instruments	Web	site.
©	1999–2005	National	Instruments	Corporation.	All	rights	reserved.
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Conventions
The	following	conventions	appear	in	this	help	file:
» The	»	symbol	leads	you	through	nested	menu	items	and	dialog	box	options	to	a	final	action.

The	sequence	File»Page	Setup»Options	directs	you	to	pull	down	the	File	menu,	select	the
Page	Setup	item,	and	select	Options	from	the	last	dialog	box.
The	 	symbol	indicates	closed	drop-down	text.	Click	the	symbol	to	display	the	text.

The	 	symbol	indicates	open	drop-down	text.	Click	the	symbol	to	hide	the	text.

This	icon	denotes	a	note,	which	alerts	you	to	important	information.

This	icon	denotes	a	caution,	which	advises	you	of	precautions	to	take	to	avoid	injury,	data
loss,	or	a	system	crash.

bold Bold	text	denotes	items	that	you	must	select	or	click	on	in	the	software,	such	as	menu	items
and	dialog	box	options.	Bold	text	also	denotes	parameter	names,	emphasis,	or	an
introduction	to	a	key	concept.

dark	red Text	in	this	color	denotes	a	caution.

green Underlined	text	in	this	color	denotes	a	link	to	a	help	topic,	help	file,	or	Web	address.

italic Italic	text	denotes	variables	or	cross	references.	This	font	also	denotes	text	that	is	a
placeholder	for	a	word	or	value	that	you	must	supply.

monospace Text	in	this	font	denotes	text	or	characters	that	you	should	enter	from	the	keyboard,	sections
of	code,	programming	examples,	and	syntax	examples.	This	font	is	also	used	for	the	proper
names	of	disk	drives,	paths,	directories,	programs,	subprograms,	subroutines,	device
names,	functions,	operations,	variables,	filenames,	and	extensions.



Related	Documentation
The	following	documents	contain	information	that	you	might	find	helpful
as	you	use	this	help	file:

DAQ	Getting	Started	Guide—This	guide	describes	how	to	install
your	NI-DAQ	7.x	software,	your	DAQ	device,	and	how	to	confirm
that	your	device	is	operating	properly.
SCXI	Quick	Start	Guide—This	guide	describes	how	to	install	and
configure	your	SCXI	chassis	and	modules,	and	how	to	confirm	that
the	chassis	is	operating	properly.
Getting	Started	with	SCXI—This	guide	is	a	handbook	to	the
installation	and	use	of	the	SCXI	chassis,	modules,	and	associated
DAQ	devices.
Device	documentation—This	documentation	describes	the
electrical	and	mechanical	aspects	of	your	device	and	contains
information	concerning	its	operation	and	programming.



Introduction	to	Measurement	&	Automation	Explorer	(MAX)
You	use	MAX	to	perform	the	following	actions	with	your	National
Instruments	measurement	and	SCXI	devices:

Configure	resources	and	other	device-specific	settings	for
measurement	devices	in	your	system
Test	the	resources	and	the	functionality	of	measurement	devices	in
your	system
Add	and	remove	a	measurement	or	SCXI	device

MAX	informs	other	NI	programs	which	products	you	have	in	your	system
and	how	they	are	configured.	When	you	run	an	application	using	NI-
DAQ,	the	software	reads	the	configuration	to	determine	which	devices
you	have	configured.

Note		Special	considerations	exist	for	specific	operating	systems.	Refer	to	Operating	System
Considerations	for	more	information.

To	check	the	system	resources	a	DAQ	device	is	using	and	to	select
attached	accessories,	expand	Devices	and	Interfaces»Traditional	NI-
DAQ	(Legacy)	Devices	in	the	configuration	tree.	Click	your	device	to	see
information	on	the	device	resources.	The	information	appears	on	the
Attributes	tab	in	the	middle	MAX	panel.	For	more	information,	refer	to
Accessing	DAQ	Devices.

Note		Press	<F5>	or	select	View»Refresh	to	refresh	the	screen	if	your	device	does	not	appear
under	Devices	and	Interfaces.



Getting	Started
Note		If	you	are	using	LabVIEW	Real-Time,	refer	to	Remote	Device	Access	and	DAQ	for
LabVIEW	Real-Time.

The	following	dropdown	lists	include	links	to	information	on	completing
the	most	common	configuration	tasks	in	MAX.



	DAQ	Devices



	RT	Series	DAQ	Devices



	SCXI	Chassis



	SCXI	Modules



	Virtual	Channels



	Custom	Scales



DAQ	Devices
Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
testing,	and	removing	DAQ	devices.
Accessing	DAQ	Devices
Adding	DAQ	Devices
Configuring	DAQ	Devices
Testing	DAQ	Devices
Removing	DAQ	Devices
Remote	Device	Access



Accessing	DAQ	Devices
To	access	DAQ	devices,	expand	Devices	and	Interfaces	in	the
configuration	tree.	From	this	location,	you	can	perform	the	following
tasks:

Add	a	new	device	to	your	system
Configure	a	device	in	your	system
Test	a	device	in	your	system
Remove	a	device	from	your	system
Add	NI-DAQ	Remote	Device	Access

For	information	on	configuring	system	settings,	refer	to	System	Settings.
Note		If	your	device	is	supported	in	both	Traditional	NI-DAQ	(Legacy)	and	NI-DAQmx,	your
device	appears	under	both	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)	Devices
and	Devices	and	Interfaces»NI-DAQmx	Devices.

Note		Refer	to	the	Hardware	Installation/Configuration	Troubleshooter	at	ni.com/support/install
for	setup	instructions	for	remote	devices	using	the	LabVIEW	Real-Time	module.
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Adding	DAQ	Devices
Select	the	operating	system	you	are	using	for	information	on	how	to	add
a	DAQ	device.

Windows	2000/XP
Windows	NT

To	add	a	remote	device,	refer	to	Adding	NI-DAQ	Remote	Device	Access.



Adding	DAQ	Devices	in	Windows	2000/XP
Plug	and	Play	Devices
Windows	2000/XP	automatically	detects	Plug	and	Play	devices.	To	add	a
Plug	and	Play	device,	follow	these	steps:

1.	 Install	your	DAQ	device	according	to	the	DAQ	Getting	Started
Guide.

2.	 Launch	MAX,	which	scans	your	operating	system	for	new
devices.

3.	 The	new	device	appears	beneath	Devices	and	Interfaces.	For
information	on	configuring	your	DAQ	device,	refer	to	Configuring
DAQ	Devices.

If	Windows	2000/XP	did	not	detect	your	Plug	and	Play	device,	refer	to
Plug	and	Play	Devices.



Remote	Device	Access
To	add	a	remote	device,	refer	to	Adding	NI-DAQ	Remote	Device	Access.



Adding	DAQ	Devices	in	Windows	NT
Plug	and	Play	Devices
ISA	and	PCI	Devices
After	you	install	your	ISA	or	PCI	device,	Windows	NT	detects	it.	Complete
the	following	steps:

1.	 Power	off	your	computer.
2.	 Install	your	DAQ	device.
3.	 Restart	your	computer.
4.	 Launch	MAX,	which	scans	your	operating	system	for	new

devices.
5.	 The	new	device	appears	beneath	Devices	and	Interfaces.	For

information	on	configuring	your	DAQ	device,	refer	to	Configuring
DAQ	Devices.

Refer	to	ISA	Devices	or	PCI	Devices	for	more	information.
PC	Card	Devices
Follow	the	same	steps	for	non-Plug	and	Play	and	parallel	port	devices
below.
Refer	to	PC	Card	Devices	for	more	information.



Non-Plug	and	Play	and	Parallel	Port	Devices
To	add	your	DAQ	devices,	follow	these	steps:

1.	 Right-click	Devices	and	Interfaces	and	select	Create	New	from
the	shortcut	menu.

2.	 Select	the	appropriate	device	option	in	the	Create	New	wizard,
and	click	Next.

3.	 Select	the	device	you	want	to	add.
4.	 The	device	configuration	wizard	guides	you	through	the	basic

device	setup.
5.	 Click	Finish	when	you	are	done.

Note		Refer	to	Operating	System	Considerations	for	more	detailed	operating	system	and
device	information.



Configuring	DAQ	Devices
To	configure	your	DAQ	devices,	follow	these	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	configure,	and	select
Properties.

–or–

Select	the	device,	and	click	the	Properties	button	at	the	top	of	the
Attributes	pane.

3.	 Select	the	appropriate	tab	to	set	the	following	configuration
options.	The	configuration	options	you	see	depend	on	your	DAQ
device.

System—System	resources
AI—Device-specific	analog	input	settings
AO—Device-specific	analog	output	settings
Accessory—Signal	conditioning	accessories
OPC—OPC	settings

4.	 Click	Apply	to	apply	changes.
5.	 Click	OK	when	you	are	finished.

Note		Refer	to	Operating	System	Considerations	for	specific	operating	system	and	device
information.



System	Settings
To	configure	your	system	settings,	follow	these	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	configure,	and	select
Properties.

–or–

Select	the	device,	and	click	Properties	at	the	top	of	the	Attributes
pane.

3.	 Click	the	System	tab	to	set	up	the	following	DAQ	device	settings.
	Device	Number
	Test	Resources
	Run	Test	Panels



AI	(Analog	Input)	Settings
To	configure	your	AI	settings,	follow	these	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	configure,	and	select
Properties.

–or–

Select	the	device,	and	click	Properties	at	the	top	of	the	Attributes
pane.

3.	 Click	the	AI	tab	to	set	up	the	following	DAQ	device	analog	input
settings.	The	settings	you	see	depend	on	your	DAQ	device.
	Polarity/Range
	Mode



AO	(Analog	Output)	Settings
To	configure	your	AO	settings,	follow	these	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	configure,	and	select
Properties.

–or–

Select	the	device,	and	click	Properties	at	the	top	of	the	Attributes
pane.

3.	 Click	the	AO	tab	to	set	up	the	following	DAQ	device	analog	output
settings.	The	analog	output	settings	you	see	depend	on	your	DAQ
device.
	Polarity
	External	Reference	Voltage
	Output	Channel	Type



Accessory	Settings
To	configure	your	accessory	settings,	follow	these	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	configure,	and	select
Properties.

–or–

Select	the	device,	and	click	Properties	at	the	top	of	the	Attributes
pane.

3.	 If	your	DAQ	device	requires	an	external	accessory,	click	the
Accessory	tab,	and	select	the	external	accessory.	Some
accessories	require	additional	configuration.	Depending	on	the
accessory,	configuration	settings	either	appear	on	the	Accessory
tab	or	require	you	to	click	the	Configure	button	to	set	additional
options.	Refer	to	the	device	documentation	for	more	information.



OPC	Settings
To	configure	your	OLE	for	Process	Control	(OPC)	settings,	follow	these
steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	configure,	and	select
Properties.

–or–

Select	the	device,	and	click	Properties	at	the	top	of	the	Attributes
pane.

3.	 Click	the	OPC	tab	and	set	the	analog	input	calibration	period	for
the	DAQ/OPC	server.

Note		You	must	install	the	OPC	server	during	NI-DAQ	installation	to	enable	OPC	settings.



Remote	Access	Settings
You	need	to	configure	remote	access	settings	only	if	you	plan	to	remotely
control	measurement	devices.	To	configure	your	remote	access	settings,
follow	these	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	configure,	and	select
Properties.

–or–

Select	the	device,	and	click	Properties	at	the	top	of	the	Attributes
pane.

3.	 Click	the	Remote	Access	tab	and	click	Set	Password.	The
password	you	set	must	be	provided	by	all	remote	device	access
(RDA)	clients	to	remotely	access	the	DAQ	device.

For	more	information	on	remote	device	access,	refer	to	Remote	Device
Access.



Testing	DAQ	Devices
Test	panels	provide	a	way	for	you	to	test	the	functionality	of	your	DAQ
device.	To	run	test	panels,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	test.	Select	Test	Panels	to
display	the	test	panel	for	the	device.
–or–
Select	the	device	you	want	to	test.	Click	Test	Panels	in	the	MAX
toolbar.
The	test	panel	appears.	You	can	view	the	analog	input,	analog
output,	counter	I/O,	and	digital	I/O	functions	of	the	device	by
clicking	the	tabs	near	the	top	of	the	window.	If	the	device	you	are
testing	is	not	a	multifunction	DAQ	device,	the	window	might	have
fewer	tabs.

3.	 If	there	is	a	problem	with	the	device,	the	Error	indicator	turns	red.
Click	Error	Codes	to	display	detailed	information	about	the	error.

4.	 Click	Close	when	you	are	finished.
Note		Neither	DAQ	devices	running	in	LabVIEW	Real-Time	nor	the	PCI-7041	RT	Series	DAQ
device	currently	support	test	panels.



Testing	Analog	Input
To	test	the	AI	functions	of	a	DAQ	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	test.	Select	Test	Panels	to
display	the	test	panel	for	the	device.
–or–
Select	the	device	you	want	to	test.	Click	Test	Panels	in	the	MAX
toolbar.
The	test	panel	appears.	The	Analog	Input	tab	is	selected	by
default.

3.	 Select	a	DAQ	device	channel	from	Channel.
4.	 Enter	High	and	Low	input	limits	for	the	y-axis	of	the	chart.
5.	 Select	a	Data	Mode.

Strip	Chart—Acquire	samples	continuously	at	a	software-
determined	rate.
One-Shot—Acquire	1000	samples	at	the	frequency	defined
by	Sample	Rate	(Hz).
Continuous—Acquire	continuous	samples	at	the	frequency
defined	by	Sample	Rate	(Hz).

Selecting	either	one-shot	or	continuous	data	mode	enables	both
Start	and	Sample	Rate	(Hz).	Enter	a	sampling	frequency	in
Sample	Rate	(Hz).	Click	Start	to	begin	data	acquisition.	Click
Stop	to	cancel	the	test.
Selecting	Strip	Chart	runs	the	test	automatically.

6.	 Select	a	Y	Scale	Mode.
Auto	Scale—MAX	selects	the	scaling	that	best	fits	the
data.
Full	Range—The	y-axis	is	scaled	using	the	High	and	Low
input	range	values.

7.	 If	there	is	a	problem	with	the	device,	the	Error	indicator	turns	red.
Click	Error	Codes	to	display	detailed	information	about	the	error.



8.	 Click	Close	when	you	are	finished.



Testing	Analog	Output
To	test	the	AO	functions	of	a	DAQ	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	test.	Select	Test	Panels	to
display	the	test	panel	for	the	device.
–or–
Select	the	device	you	want	to	test.	Click	Test	Panels	in	the	MAX
toolbar.
The	test	panel	appears.	Click	the	Analog	Output	tab.

3.	 Select	a	DAQ	device	channel	from	Channel	Selection.
4.	 Select	an	Output	Mode.

DC	Voltage—Output	a	user-defined	DC	voltage.
Sine	Generator—Output	a	user-defined	AC	voltage.

Selecting	DC	Voltage	enables	the	DC	Voltage	slider.	Select	a
value	using	the	slider,	or	enter	a	value	in	the	field.
Selecting	Sine	Generator	enables	both	Update	Rate	and
Sinewave	Amplitude.	Enter	a	refresh	rate	for	Update	Rate.	Use
the	slider	bar	to	select	a	value	for	Output	Voltage/Amplitude,	or
enter	a	value	in	the	field.

5.	 Click	Update	Channel	to	output	the	voltage	on	the	selected
channel.

6.	 If	there	is	a	problem	with	the	device,	the	Error	indicator	turns	red.
Click	Error	Codes	to	display	detailed	information	about	the	error.

7.	 Click	Close	when	you	are	finished.



Testing	Counter	I/O
To	test	the	counter	I/O	functions	of	a	DAQ	device,	complete	the	following
steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	test.	Select	Test	Panels	to
display	the	test	panel	for	the	device.
–or–
Select	the	device	you	want	to	test.	Click	Test	Panels	in	the	MAX
toolbar.
The	test	panel	appears.	Click	the	Counter	I/O	tab.

3.	 Select	a	DAQ	device	GPCTR	channel	from	Counter.
4.	 Select	a	Counter	Mode.

Pulse	Train	Generation—Output	a	periodic	signal	with
user-defined	frequency	and	duty	cycle.
Single	Pulse	Generation—Output	a	single	pulse	with	user-
defined	delay	and	pulse	width.
Simple	Event	Counting—Count	a	user-defined	event.

If	you	select	Pulse	Train	Generation,	enter	Frequency	and	Duty
Cycle	values.
If	you	select	Single	Pulse	Generation,	enter	Delay	(sec)	and
Pulse	Width	(sec)	values.
If	you	select	Simple	Event	Counting,	select	an	Event	Source	from
the	list	of	available	signals.	When	you	start	the	counter,	Counter
Value	continuously	updates	with	the	current	value.

5.	 Click	Start	to	begin	the	test.	Click	Reset	to	cancel	the	test.
6.	 If	there	is	a	problem	with	the	device,	the	Error	indicator	turns	red.

Click	Error	Codes	to	display	detailed	information	about	the	error.
7.	 Click	Close	when	you	are	finished.



Testing	Digital	I/O
To	test	the	DIO	functions	of	a	DAQ	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	test.	Select	Test	Panels	to
display	the	test	panel	for	the	device.
–or–
Select	the	device	you	want	to	test.	Click	Test	Panels	in	the	MAX
toolbar.
The	test	panel	appears.	Click	the	Digital	I/O	tab.

3.	 For	each	line	listed	under	Line	Direction	Selection,	click	the	Input
or	Output	radio	button	to	select	an	I/O	direction.

4.	 If	output	is	selected,	click	the	Logic	Level	for	the	line	to	select
either	a	high	(1)	or	low	(0)	state.	Line	State	identifies	high	output
by	turning	the	indicator	red,	and	low	output	by	leaving	the
indicator	unlit.

5.	 If	there	is	a	problem	with	the	device,	the	Error	indicator	turns	red.
Click	Error	Codes	to	display	detailed	information	about	the	error.

6.	 Click	Close	when	you	are	finished.



Removing	DAQ	Devices
To	remove	a	DAQ	device,	follow	these	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices	in	the	configuration	tree.

2.	 Right-click	the	device	you	want	to	remove,	and	select	Delete.

–or–

Select	the	device,	and	click	Delete	at	the	top	of	the	Attributes
pane.

3.	 A	dialog	box	asks	you	to	confirm	you	want	to	remove	the	selected
DAQ	device.	Click	Yes	to	remove	the	device,	or	click	No	to	cancel
this	action.



Remote	Device	Access	(RDA)	and	DAQ	for	LabVIEW	Real-
Time
Refer	to	the	following	topics	for	more	information	on	adding	and
configuring	RDA	devices.
Adding	Traditional	NI-DAQ	(Legacy)	Remote	Device	Access
Starting	Remote	DAQ	Configuration
Using	the	Remote	DAQ	Configuration	Dialog	Box
Creating	an	RDA	Server



Adding	Traditional	NI-DAQ	(Legacy)	Remote	Device	Access
The	Traditional	NI-DAQ	(Legacy)	Remote	Device	Access	(RDA)	feature
lets	you	use	your	computer	to	control	National	Instruments	DAQ	devices
plugged	into	other	computers	on	the	same	network.	This	feature	works
only	with	programs	written	using	the	LabVIEW	Traditional	NI-DAQ
(Legacy)	VIs.	Your	programs	do	not	require	modifications	to	use	this
feature.	Access	to	the	remote	devices	is	transparent	to	your	program.
To	add	a	remote	device,	follow	these	steps:

1.	 Right-click	Devices	and	Interfaces»Traditional	NI-DAQ
(Legacy)	Devices,	and	select	Add	Device.

2.	 In	the	Add	Device	window,	select	the	Remote	Device	option,	and
click	Next.

3.	 In	the	Select	Remote	Computer	window,	enter	the	remote
computer	name	or	IP	address	in	the	Remote	Computer	Name/IP
Address	edit	box.	Or,	click	Browse	to	browse	the	network	for	the
computer	name.	Click	Next.

Note		Your	computer	may	not	recognize	a	remote	computer	name	starting	with	numbers	or
using	apostrophes.

4.	 Select	the	device	you	want	to	use	from	the	Remote	Configuration
device	list.	Click	Next.

5.	 Select	the	local	device	number	you	want	to	use.
6.	 Click	Finish.

To	set	a	password	for	your	RDA	system,	refer	to	Remote	Access
Settings.



Starting	Remote	DAQ	Configuration
To	connect	to	a	computer	for	remote	configuration	of	DAQ	devices,	follow
these	steps:

1.	 From	the	MAX	toolbar,	select	Tools»NI-DAQ
Configuration»Remote	DAQ	Configuration.	The	Select	Remote
Computer	window	opens.

2.	 Type	in	the	name	or	IP	address	of	the	remote	computer,	or	click
Browse	to	browse	the	network.

3.	 Type	in	the	RDA	password.	For	more	information	on	setting	the
RDA	password,	refer	to	Remote	Access	Settings.

4.	 Click	OK.	If	the	connection	is	successful,	the	Remote	DAQ
Configuration	dialog	box	opens.	If	the	connection	fails,	an	error
message	opens.	Click	OK	to	continue.



Using	the	Remote	DAQ	Configuration	Dialog	Box
The	left	pane	of	the	Remote	DAQ	Configuration	dialog	box	shows	a	tree
view	of	the	configured	objects	on	the	remote	computer.	Objects	can	be
DAQ	devices,	SCXI	chassis	and	modules,	virtual	channels,	and	custom
scales.	Click	an	object,	then	do	one	of	the	following:

To	view	and	edit	the	properties	of	the	object,	click	Properties.
To	delete	the	object,	click	Delete.
To	add	an	object	to	a	category,	select	the	category	and	click	Add.
To	save	your	changes,	click	Save.

When	you	are	finished	configuring	the	remote	computer,	click	Exit.
To	modify	the	configuration	of	a	remote	computer,	the	remote	computer
must	be	running	the	NI-DAQ	RDA	Server,	or	it	must	be	a	LabVIEW	Real-
Time	target.	If	the	computer	is	not	a	LabVIEW	Real-Time	target,	it	must
have	a	valid	DAQ	configuration	file.	You	can	create	a	DAQ	configuration
file	by	running	MAX	on	the	remote	computer.
For	information	on	connecting	to	a	remote	computer,	see	Starting
Remote	DAQ	Configuration.



Creating	an	RDA	Server
To	create	an	RDA	server,	follow	these	steps:

1.	 Install	NI-DAQ	on	both	the	RDA	server	and	client	according	to	the
DAQ	Getting	Started	Guide.

2.	 Install	and	configure	your	DAQ	devices	on	the	RDA	client.
3.	 Confirm	the	devices	on	the	RDA	client	are	working	properly	by

testing	their	resources.	For	more	information,	refer	to	Testing	DAQ
Devices.

4.	 On	the	RDA	server,	launch	the	NI-DAQ	RDA	Server	Utility	by
clicking	Start»Programs»National	Instruments»NI-
DAQ»Remote	Device	Access	Server.	For	your	computer	to	act
as	an	RDA	server,	you	must	leave	the	RDA	Server	Utility	running.

Note		If	you	want	this	computer	to	become	an	RDA	server	every	time	it	starts	up,	place	a
shortcut	to	the	NI-DAQ	RDA	Server	Utility	in	your	Startup	folder.



RT	Series	DAQ	Devices	(NI	PCI-7041/6040E)
Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
and	removing	RT	Series	DAQ	devices.
Adding	RT	Series	DAQ	Devices
Configuring	RT	Series	DAQ	Devices
Locking	RT	Series	DAQ	Devices
Rebooting	RT	Series	DAQ	Devices
Removing	RT	Series	DAQ	Devices



Adding	RT	Series	DAQ	Devices
To	add	an	RT	Series	DAQ	device,	complete	the	following	steps:

1.	 Install	the	RT	Series	DAQ	device	according	to	the	device
documentation.

2.	 Open	MAX	to	scan	your	operating	system	for	new	devices.	The
new	device	appears	in	Devices	and	Interfaces	as	RT::<device
number>.

For	information	on	configuring	the	DAQ	device,	refer	to	Configuring	RT
Series	DAQ	Devices.



Configuring	and	Renaming	RT	Series	DAQ	Devices
To	configure	an	RT	Series	DAQ	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Right-click	the	device	you	want	to	configure.	Select	Properties.

–or–
Select	the	device	you	want	to	configure.	Click	Properties	in	the
MAX	toolbar.

3.	 Select	the	appropriate	tab	to	set	the	configuration	options.
	General
	Settings

4.	 Click	OK	when	you	are	finished.
To	rename	a	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Right-click	the	device	you	want	to	rename.	Select	Rename.
3.	 Type	the	new	device	name.	Use	only	alphanumeric	characters	for

the	name.	Do	not	use	punctuation	or	spaces.	Press	<Enter>	or
click	anywhere	on	the	screen	when	finished.



Locking	RT	Series	DAQ	Devices
Locking	an	RT	Series	DAQ	device	protects	the	device	from	other	users
by	requiring	a	password	to	perform	any	functions	on	the	device.
Complete	the	following	steps	to	lock	a	device:

1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Right-click	the	device	you	want	to	lock.	Select	Lock.

–or–
Select	the	device	you	want	to	lock.	Click	Lock	in	the	MAX	toolbar.

3.	 Enter	a	password.	Enter	the	password	again	for	confirmation.
Click	OK	to	lock	the	device.

Complete	the	following	steps	to	unlock	the	device.
1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Right-click	the	device	you	want	to	unlock.	Select	Unlock.

–or–
Select	the	device	you	want	to	unlock.	Click	Unlock	in	the	MAX
toolbar.

3.	 Enter	the	password.	Click	OK	to	unlock	the	device.



Rebooting	RT	Series	DAQ	Devices
Rebooting	an	RT	Series	DAQ	device	performs	a	hardware	reboot	of	the
device.	A	reboot	aborts	any	running	tasks	and	restores	the	device	to	its
default	settings.	Complete	the	following	steps	to	reboot	a	device:

1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Right-click	the	device	you	want	to	reboot.	Select	Reboot.

–or–
Select	the	device	you	want	to	reboot.	Click	Reboot	in	the	MAX
toolbar.

3.	 A	message	appears,	indicating	success	or	failure.	Click	OK	to
continue.



Removing	RT	Series	DAQ	Devices
To	remove	an	RT	Series	DAQ	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Right-click	the	device	you	want	to	remove	and	select	Delete.
3.	 A	dialog	box	prompts	you	to	confirm	removal	of	the	device.	Click

Yes	to	remove	the	device	or	No	to	cancel.



SCXI	Devices
Note		If	you	are	using	a	system	running	LabVIEW	Real-Time,	refer	to	the	Remote	Systems	help
for	configuration	instructions	for	remote	targets.	Click	Help»Help	Topics»Remote	Systems.
For	additional	DAQ	device	configuration	instructions	with	RT	Series	products,	refer	to	the
Hardware	Installation/Configuration	Troubleshooter	at	ni.com/support/install	for	SCXI
configuration	instructions	with	RT	Series	products.	Select	Real-Time	(RT)	from	the	left	menu,
click	Real-Time	Configuration	Wizard,	and	select	SCXI	on	RT	Systems.

Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
testing,	and	removing	SCXI	devices.
Accessing	SCXI	Devices
SCXI	Chassis
SCXI	Modules
Testing	SCXI	Configuration

javascript:WWW(WWW_Install)


Accessing	SCXI	Devices
The	SCXI	chassis	and	modules	you	add	to	your	configuration	appear
beneath	Devices	and	Interfaces	in	the	configuration	tree.	From	this
location,	you	can	perform	the	following	tasks:

Add	SCXI	chassis	and	SCXI	modules	to	your	configuration
Configure	SCXI	chassis	and	SCXI	modules	in	your	configuration
Test	an	SCXI	chassis	and	its	modules
Remove	SCXI	chassis	and	SCXI	modules	from	your	configuration



SCXI	Chassis
Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
and	removing	SCXI	chassis.
Adding	SCXI	Chassis
Configuring	SCXI	Chassis
Removing	SCXI	Chassis



Adding	SCXI	Chassis
To	add	your	SCXI	chassis,	follow	these	steps:

1.	 Right-click	Devices	and	Interfaces,	and	select	Create	New.
2.	 In	the	Create	New	window,	go	to	Devices	and

Interfaces»Traditional	NI-DAQ	(Legacy)	Devices.	Select	the
SCXI	chassis	you	want	to	add.

3.	 Click	Finish.
4.	 In	the	dialog	boxes	that	follow,	configure	your	settings.
5.	 Click	Finish	when	you	are	done.

You	also	can	add	an	SCXI	chassis	without	using	the	Create	New	window.
Complete	the	following	steps:

1.	 Right-click	Devices	and	Interfaces»Traditional	NI-DAQ
(Legacy)	Devices,	and	select	Add	SCXI	Chassis.

2.	 In	the	Add	SCXI	Device	window,	select	SCXI	Chassis.	Click
Next.

3.	 In	the	dialog	boxes	that	follow,	configure	your	settings.
4.	 Click	Finish	when	you	are	done.

Note		See	Operating	System	Considerations	for	specific	operating	system	and	device
information.



Configuring	SCXI	Chassis
To	configure	your	SCXI	chassis,	follow	these	steps:

1.	 Right-click	the	SCXI	chassis	you	want	to	configure,	and	select
Properties.

2.	 The	General	dialog	box	opens.	The	following	configuration
settings	appear	in	the	window	(depending	on	the	device	you
choose):
	Chassis	ID
	Chassis	Address
	Control	SCXI	with	Internal	Bus	(PXI-1010	Only)

3.	 Click	Next.
4.	 In	the	SCXI	Auto-Detect	dialog	box,	select	Yes	if	you	want	NI-

DAQ	to	automatically	detect	the	SCXI	modules	in	your	chassis.	If
you	do	not	want	NI-DAQ	to	automatically	detect	the	SCXI
modules	in	your	chassis,	select	No.	You	can	manually	add	SCXI
modules	to	your	configuration.

Note		Neither	DAQ	devices	running	in	LabVIEW	Real-Time	nor	the	PCI-7041	RT	Series	DAQ
device	currently	support	the	SCXI	auto-detect	option.

5.	 Click	Next.
6.	 In	the	Select	SCXI	Communication	Path	dialog	box,	select	the

communication	path	between	your	chassis	and	the	computer,	if
necessary.

7.	 Click	Next.
8.	 The	SCXI	Auto-Detection	Results	dialog	box	displays	the	modules

found	in	the	chassis.	Select	the	module	cabled	to	the	DAQ	device.
9.	 Click	Finish	when	you	are	done.

Note		Refer	to	Operating	System	Considerations	for	specific	operating	system	and	device
information.



Removing	SCXI	Chassis
To	remove	your	SCXI	chassis,	follow	these	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices.	Right-click	the	chassis	you	want	to	remove,	and	select
Delete.

–or–

Select	the	chassis	you	want	to	remove,	and	click	Delete	at	the	top
of	the	Attributes	pane.

2.	 A	dialog	box	opens	for	you	to	confirm	the	removal	of	the	selected
SCXI	chassis.	Click	Yes	to	remove	the	chassis	or	click	No	to
cancel.

Caution		Removing	an	SCXI	chassis	also	removes	any	SCXI	module	configuration	information
you	have	configured	in	the	selected	chassis.



SCXI	Modules
Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
and	removing	SCXI	modules.
Adding	SCXI	Modules
Configuring	SCXI	Modules
Removing	SCXI	Modules



Adding	SCXI	Modules
Before	you	can	add	an	SCXI	module,	you	must	add	an	SCXI	chassis.	To
add	an	SCXI	module,	follow	these	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices.

2.	 Expand	the	SCXI	chassis.
3.	 Right-click	a	module	labeled	Empty,	and	select	Insert.
4.	 In	the	Select	SCXI	Module	window,	select	the	module	you	want	to

add	from	the	list.	Click	Next.
5.	 In	the	General,	Channel,	and	Accessory	windows,	configure	your

module	settings.
6.	 Click	Finish	when	you	are	done.

Note		Refer	to	Operating	System	Considerations	for	specific	operating	system	and	device
information.



Configuring	SCXI	Modules
To	configure	your	SCXI	module,	follow	these	steps:

1.	 Expand	Devices	and	Interfaces»Traditional	NI-DAQ	(Legacy)
Devices.

2.	 Right-click	the	module	you	want	to	configure,	and	select
Properties.

–or–

Select	the	module,	and	click	Properties	at	the	top	of	the
Attributes	pane.

3.	 A	configuration	dialog	box	opens.	The	following	configuration	tab
options	vary	depending	on	the	selected	module.
	General
	Channel
	Accessory

4.	 Click	OK	when	you	are	done.
Note		Refer	to	Operating	System	Considerations	for	specific	operating	system	and	device
information.



Removing	SCXI	Modules
To	remove	your	SCXI	module,	follow	these	steps:

1.	 In	the	configuration	tree,	right-click	the	module	you	want	to
remove	and	select	Delete.

2.	 A	dialog	box	opens	asking	you	to	confirm	you	want	to	remove	the
selected	SCXI	module.	Click	Yes	to	remove	the	module	or	click
No	to	cancel.



Testing	SCXI	Configuration
To	test	your	SCXI	configuration,	follow	these	steps:

1.	 In	the	configuration	tree,	right-click	the	SCXI	chassis	you	want	to
test.

2.	 Select	Test.
MAX	verifies	your	SCXI	configuration	by	reading	the	module	ID	of	each
configured	SCXI	module	and	comparing	it	against	the	modules	you
configured.	MAX	notifies	you	if	there	is	any	discrepancy,	or	if	the	SCXI
communication	path	was	not	set	up	correctly.
Refer	to	your	SCXI	device	documentation	for	troubleshooting	information.

Note		Neither	DAQ	devices	running	in	LabVIEW	Real-Time	nor	the	PCI-7041	RT	Series	DAQ
device	currently	support	SCXI	configuration	testing.



Virtual	Channels
To	access	the	channel	list,	expand	Data	Neighborhood	in	the
configuration	tree.
To	create	a	virtual	channel,	right-click	Data	Neighborhood,	and	select
Create	New.	Select	Traditional	NI-DAQ	Virtual	Channel.
To	edit	a	virtual	channel,	right-click	the	channel	you	want	to	edit	from	the
list	of	channels.	Select	Properties.
To	copy	a	virtual	channel,	right-click	the	channel	you	want	to	edit	from	the
list	of	channels.	Select	Duplicate.
To	test	a	virtual	channel,	right-click	the	channel	you	want	to	edit	from	the
list	of	channels.	Select	Test.
To	delete	a	virtual	channel,	right-click	the	channel	you	want	to	edit	from
the	list	of	channels.	Select	Delete.
To	define	a	custom	scale	for	use	by	the	channel,	right-click	Scales.



Creating	Virtual	Channels
To	create	a	virtual	channel,	follow	these	steps:

1.	 Right-click	Data	Neighborhood	and	select	Create	New	from	the
shortcut	menu.

2.	 Select	Traditional	NI-DAQ	Virtual	Channel,	and	click	Finish.
3.	 The	Create	New	Channel	wizard	opens.	Use	this	wizard	to

configure	your	virtual	channel.
4.	 Select	the	type	of	channel	you	want	to	configure.	Click	Next.
5.	 Enter	the	name	of	your	channel	and	a	description	of	the	channel.

Click	Next.
6.	 The	rest	of	the	wizard	helps	you	with	configuration	specific	to	the

type	of	channel.
Analog	Input
Analog	Output
Digital	I/O



Analog	Input
Click	any	of	the	following	items	to	configure	your	analog	input	channels.
	Voltage	Input	Channel
	Current	Input	Channel
	Resistance	Input	Channel
	Frequency	Input	Channel
	Known-Type	Thermocouple	Channel
	Custom	Thermocouple	Channel
	RTD	Channel
	Accelerometer	Channel
	LVDT/RVDT	Channel
	Strain	Gauge	Channel



Built-In
Select	Built-In	as	your	CJC	type	if	your	DAQ	device	or	its	accessory
contains	a	CJC	sensor.



User-Supplied	CJC	Channel
Select	User-Supplied	CJC	Channel	as	your	CJC	type	to	use	one	of
your	configured	input	channels	as	your	CJC	channel.	In	the	CJC	Channel
Name	menu,	MAX	displays	the	channels	that	meet	the	following	criteria:

The	channel	must	be	an	existing	analog	input	channel.
The	channel	must	be	configured	to	measure	temperature	in
degrees	C,	F,	K,	or	R.
The	channel	must	be	configured	in	one	of	the	following	ways:

If	you	have	specified	a	plug-in	board	as	your	device,
configure	the	channel	to	use	the	plug-in	board	or	any	of	the
modules	connected	to	that	plug-in	board.
If	you	have	specified	a	module	as	your	device,	configure	the
channel	to	use	the	module,	the	plug-in	board	to	which	the
module	is	connected,	or	any	of	the	other	modules	connected
to	that	plug-in	board.

Connect	the	user-supplied	CJC	channel	to	a	sensor	that	reads	the
ambient	temperature	at	the	location	where	you	terminate	your
thermocouple	channel.



User	Value
Select	User	Value	as	your	CJC	type	if	you	do	not	have	an	ambient
temperature	sensor	available	for	CJC.	With	this	option,	the	ambient
temperature	is	estimated	but	not	measured.	The	default	is	25°	C	(typical
room	temperature)	as	the	CJC	value	to	use	in	the	thermocouple
conversion.	Edit	this	value	to	use	a	different	temperature.



Analog	Output
Click	any	of	the	following	items	to	configure	your	analog	output	channels.
	Voltage	Output	Channel
	Current	Output	Channel



Digital	I/O
Click	any	of	the	following	items	to	learn	more	about	the	types	of	digital
input	and	output	channels.
	Digital	Input	Channel—Read	from	Port
	Digital	Input	Channel—Read	from	Line
	Digital	Output	Channel—Write	to	Port
	Digital	Output	Channel—Write	to	Line



Editing	Virtual	Channels
To	edit	a	channel,	follow	these	steps:

1.	 Expand	Data	Neighborhood	in	the	configuration	tree.
2.	 Right-click	the	channel	you	want	to	edit,	and	select	Properties.

–or–

Select	the	channel,	and	click	Properties	at	the	top	of	the
Attributes	pane.

3.	 The	configuration	window	opens	and	displays	your	editing
options:
	Settings	common	to	all	configurations
	Analog	Input
	Analog	Output
	Digital	I/O

4.	 Click	OK	when	you	are	finished.



All	Configurations
Refer	to	the	following	topics	for	more	information	on	editing	configuration
options	for	all	virtual	channels.
Editing	Channel	Names
Editing	Channel	Descriptions



Editing	Channel	Names
To	edit	your	channel	name,	follow	these	steps:

1.	 Right-click	the	channel	you	want	to	edit,	and	select	Properties.

–or–

Select	the	channel,	and	click	Properties	at	the	top	of	the
Attributes	pane.

2.	 Click	Edit	Name.
3.	 Edit	the	text	in	the	Channel	Name	selection	box.
4.	 Click	outside	the	selection	box	or	press	the	tab	key	when	you	are

finished.



Editing	Channel	Descriptions
To	edit	your	channel	description,	follow	these	steps:

1.	 Right-click	the	channel	you	want	to	edit,	and	select	Properties.

–or–

Select	the	channel,	and	click	Properties	at	the	top	of	the
Attributes	pane.

2.	 Edit	the	text	in	the	Description	edit	box.



AI	Configuration
Refer	to	the	following	topics	for	more	information	on	editing	configuration
options	for	AI	virtual	channels.
Editing	AI	Physical	Quantity
Editing	the	Sensor
Editing	the	AI	Hardware
Editing	AI	Miscellaneous	Properties



Editing	AI	Physical	Quantity
The	physical	quantity	field	defines	the	unit	and	range	of	the	physical
quantity	you	are	measuring	with	a	given	DAQ	device	channel.
Units In	the	Units	selection	box,	enter	the	appropriate	unit.	For	non-temperature	measurements,	you

can	enter	any	unit	you	want	to	use.	For	temperature	measurements,	you	can	choose	Deg	C,
Deg	F,	Deg	K,	or	Deg	R.

Range In	the	Range	selection	boxes,	enter	the	minimum	and	maximum	values	of	the	physical	quantity
you	are	measuring.

For	example,	to	configure	a	channel	to	read	a	temperature	that	can	vary
from	0	to	100°	C,	set	the	Units	to	Deg	C,	the	minimum	range	to	0,	and
the	maximum	range	to	100.



Editing	the	Sensor
The	Sensor	section	defines	the	sensor	type	connected	to	the	DAQ
channel.	The	sensor	you	select	determines	which	scaling	options	are
available	for	the	conversion	of	the	sensor	measurement	to	the	physical
quantity.
Sensor,
Unit,
Range

In	the	Sensor	selection	box,	select	a	sensor.	For	information	on	analog	input	sensor	types,
refer	to	Analog	Input.	The	sensor	you	select	controls	the	sensor	unit	displayed	for	this
channel.	The	sensor	also	determines	the	physical	quantity	unit	you	can	select.	Some	sensor
selections	have	pre-selected	ranges.	When	you	select	one	of	these	sensors,	your	sensor
range	automatically	changes	to	the	appropriate	range	in	terms	of	the	measurement	units.

Scaling
Formula

In	the	Scaling	Formula	selection	box,	select	your	scaling	option.	Standard	RTD	and
Thermocouple	measurement	options	already	contain	defined	scaling	formulas,	so	you	do	not
specify	the	conversion.



Scaling	Formula
The	scaling	formula	section	defines	which	formula	Traditional	NI-DAQ
(Legacy)	uses	to	scale	the	data	on	the	specified	channel.
No	Scaling—Matches	the	physical	quantity	range	to	the	sensor	or
actuator	range.
Map	Ranges—Computes	a	linear	conversion	between	the	sensor	or
actuator	range	and	the	physical	quantity	range.
New	Custom	Scale—Enables	you	to	create	a	custom	scale	for	your
channel.
If	you	have	previously	configured	a	custom	scale,	the	scale	name	is
included	in	the	Scaling	Formula	list.



Editing	the	AI	Hardware
The	Hardware	section	defines	which	DAQ	device	and	which	channel	on
the	device	you	are	assigning	to	this	virtual	channel.	You	also	can	define
the	input	mode	for	the	DAQ	device	you	choose.
Device In	the	Device	selection	box,	select	a	DAQ	device.	The	selection	box	lists	all	devices	in	your

system	with	analog	input	channels.	The	options	in	the	Hardware	panel	change	depending	on
which	sensor	you	selected.	MAX	determines	whether	the	sensor	you	have	selected
measures	voltage,	current,	resistance,	or	frequency.	It	also	determines	the	quantities	you	can
measure	directly	with	a	DAQ	device	and	prompts	you	for	any	further	information	needed.	If
you	use	a	thermocouple	to	measure	temperature,	you	must	supply	additional	information	in
the	Hardware	section.

Channel In	the	Channel	selection	box,	select	a	channel	for	your	DAQ	device.	Some	channels	are
reserved	because	they	are	used	by	your	system	configuration	and	therefore	are	not	available
for	configuration.	The	Channel	menu	marks	these	channels	with	a	(sys)	next	to	the	channel
number.	The	Channel	selection	box	also	marks	channels	already	used	by	other	virtual
channels	with	a	(cfg).

If	you	select	channels	marked	with	a	(sys)	or	a	(cfg),	your	virtual	channel	is	marked	as	invalid.
However,	if	you	are	swapping	two	channels,	this	invalid	situation	is	only	temporary,	and	the
configuration	becomes	valid	when	another	configuration	is	no	longer	attached	to	the	DAQ
hardware	channel.

Pin	# After	you	select	a	device	and	channel,	the	Hardware	section	displays	the	pin	number	or
name	corresponding	to	the	selected	channel	as	labeled	on	the	device	accessory	if	one	is
connected,	or	on	the	device	output	connector	if	no	accessory	is	connected	to	the	device.

Input
Mode

In	the	Input	Mode	selection	box,	select	the	appropriate	mode	for	your	DAQ	device.
Depending	on	the	capability	of	your	DAQ	device,	you	can	choose	between	Differential,
Referenced	Single	Ended,	Nonreferenced	Single	Ended,	or	4-Wire.	If	the	input	mode
selection	is	hardware	jumper-configurable	or	is	not	software-selectable	by	channel,	the
Hardware	panel	only	offers	the	mode	currently	configured.	Be	sure	to	set	your	actual
hardware	jumper	configuration	correctly	in	the	device	configuration	panel.	MAX	automatically
selects	the	factory-default	setting	for	your	device,	so	your	configuration	should	be	correct	as
long	as	you	have	not	changed	any	device	jumpers.	Refer	to	the	device	documentation	for
information	on	when	to	use	each	input	mode	and	how	to	wire	the	input	for	the	mode	selected.



Editing	AI	Miscellaneous	Properties
The	Miscellaneous	section	defines	values	used	only	with	specific	types	of
measurement.	Depending	on	the	measurement,	some	or	all	of	the
properties	may	be	disabled.
Current	Sense
Resistor	Value

Enter	the	resistor	value	in	ohms.	Selecting	a	current	input	channel	enables	this	value
for	editing.

Resonant
Frequency

Enter	the	resonant	frequency	value	in	hertz.	Selecting	an	accelerometer	input	channel
enables	this	value	for	editing.

Excitation
Source,
Current/Voltage

Select	the	excitation	source.	Depending	on	the	measurement,	either	enter	a	current
value	in	milliamps	or	a	voltage	value	in	volts.	Selecting	a	resistance,	RTD,
accelerometer,	LVDT/RVDT,	or	strain	gauge	input	channel	enables	this	value	for
editing.

Sensitivity
Units,	Value

Select	the	sensitivity	value	units.	Enter	a	sensitivity	value.	Selecting	a	RTD,
accelerometer,	or	LVDT/RVDT	input	channel	enables	this	value	for	editing.

CJC	Source,
User	Channel,
Temperature

Select	a	value	for	CJC	source.	If	the	source	is	a	user	value,	enter	a	value	in	the
Temperature	edit	box.	If	the	source	is	user-supplied,	select	a	user-defined	channel.
Selecting	a	known-type	thermocouple	or	custom	thermocouple	input	channel	enables
this	value	for	editing.



AO	Configuration
Refer	to	the	following	topics	for	more	information	on	editing	configuration
options	for	AO	virtual	channels.
Editing	AO	Physical	Quantity
Editing	the	Actuator
Editing	the	AO	Hardware



Editing	AO	Physical	Quantity
The	Physical	Quantity	section	defines	the	unit	and	range	of	the	physical
quantity	you	are	controlling	with	a	given	DAQ	device	channel.
Units In	the	Units	selection	box,	enter	the	appropriate	unit.

Range In	the	Range	selection	boxes,	enter	the	minimum	and	maximum	values	of	the	physical	quantity
you	are	controlling.



Editing	the	Actuator
The	Actuator	section	defines	the	actuator	type	connected	to	the	DAQ
channel.	The	actuator	you	select	gives	you	complete	control	over	how
the	scaling	is	done	to	convert	from	the	actuator	to	the	physical	quantity.
Actuator,
Unit,
Range

In	the	Actuator	selection	box,	select	an	actuator.	For	information	on	analog	output	types,	see
Analog	Output.	The	actuator	you	select	controls	the	actuator	units	displayed	for	this	channel.
Some	actuator	selections	also	have	pre-selected	ranges.	Your	actuator	range	automatically
changes	to	the	appropriate	range	in	terms	of	your	actuator	units	when	you	select	one	of
these	actuators.

Actuator
Scaling

In	the	Scaling	Formula	selection	box,	select	your	scaling	option.	The	voltage	or	current
output	options	give	you	complete	control	over	how	the	actuator	is	scaled.



Editing	the	AO	Hardware
The	Hardware	section	defines	which	DAQ	device	and	which	channel	on
the	device	you	are	assigning	to	this	virtual	channel.
Device In	the	Device	selection	box,	select	a	DAQ	device.	The	selection	box	lists	all	devices	in	your

system	with	analog	output	channels.	The	devices	in	the	DAQ	device	selection	box	change
depending	on	which	actuator	you	have	selected.	MAX	determines	whether	the	actuator	you
have	selected	uses	voltage	or	current.

Channel In	the	Channel	selection	box,	select	a	channel	for	your	DAQ	device.	Some	channels	are
reserved	because	they	are	used	by	your	system	configuration	and	therefore	are	not	available
for	configuration.	The	Channel	menu	marks	these	channels	with	a	(sys)	next	to	the	channel
number.	The	Channel	selection	box	also	marks	channels	already	used	by	other	virtual
channels	with	a	(cfg).

If	you	select	channels	marked	with	a	(sys)	or	a	(cfg),	your	virtual	channel	is	marked	as	invalid.
However,	if	you	are	swapping	two	channels,	this	invalid	situation	is	only	temporary,	and	the
configuration	becomes	valid	when	another	configuration	is	no	longer	attached	to	the	DAQ
hardware	channel.

Pin	# After	you	select	a	device	and	channel,	the	Hardware	panel	displays	the	pin	number	or	name
corresponding	to	the	selected	channel	as	labeled	on	the	device	accessory,	if	one	is
connected,	or	on	the	device	output	connector	if	no	accessory	is	connected	to	the	device.



DIO	Configuration
Refer	to	the	following	topics	for	more	information	on	editing	configuration
options	for	DIO	virtual	channels.
Editing	the	DIO	Hardware
Editing	Signal	Inversion



Editing	the	DIO	Hardware
The	Hardware	section	defines	which	DAQ	device	and	which	port	and	line
on	the	device	you	are	assigning	to	this	virtual	channel.
Device In	the	Device	selection	box,	select	a	DAQ	device.	The	selection	box	lists	all	devices	in	your

system	with	digital	ports.	If	you	have	selected	Read	from	Line	or	Write	to	Line,	you	select	a
port	and	a	line.	If	you	have	selected	Read	from	Port	or	Write	to	Port,	you	only	select	a	port.

Port In	the	Port	selection	box,	select	the	port	connected	to	your	signals.

Unidirectional	ports	are	marked	by	read	only	or	write	only	following	the	port	name.	If	you
configure	your	signal	to	use	a	unidirectional	port	in	the	wrong	direction,	the	configuration	is
marked	as	invalid.

Ports	with	at	least	one	line	already	reserved	are	marked	by	a	(sys)	or	a	(cfg)	following	the	port
name.	A	(sys)	denotes	that	at	least	one	line	of	the	port	is	reserved	by	the	system.	A	(cfg)
denotes	that	at	least	one	line	of	the	port	is	reserved	by	another	virtual	channel.	An	(N/A)
following	a	port	name	indicates	that	the	port	is	not	available	on	the	device.	If	you	configure	your
signal	to	use	a	reserved	or	unavailable	port,	the	configuration	is	marked	as	invalid.

Line For	some	devices,	all	lines	on	the	same	port	must	be	configured	in	the	same	direction.	If	you
select	a	line	on	a	port	and	other	digital	virtual	channels	are	using	other	lines	of	the	same	port
for	the	opposite	direction,	your	virtual	channel	will	become	invalid	if	the	DAQ	device	cannot	mix
directions	on	the	port.

When	you	select	a	device,	port,	and	line,	the	Hardware	section	displays	the	pin	number	or
name	corresponding	to	the	selected	line.

If	you	are	configuring	the	channel	to	Read	from	Line	or	Write	to	Line,	the	Line	menu	lists	all	the
available	lines	on	the	selected	device	port.	The	Line	menu	marks	lines	already	used	by	your
system	configuration	or	other	virtual	channels	with	a	(sys)	or	a	(cfg),	respectively.	If	you	select
lines	marked	with	a	(sys)	or	a	(cfg),	your	virtual	channel	is	marked	as	invalid.	However,	in	the
(cfg)	case,	if	you	are	swapping	two	lines,	this	situation	is	only	temporary	and	the	configuration
becomes	valid	when	another	virtual	channel	is	no	longer	attached	to	the	DAQ	hardware	line.



Editing	Signal	Inversion
The	Signal	Inversion	section	turns	on	or	off	the	inversion	of	individual
lines	in	your	selected	digital	port.	If	you	are	reading	or	writing	on	a	single
line,	you	can	turn	inversion	on	or	off	for	just	that	line	in	the	port.	If	you	are
reading	or	writing	the	entire	port,	you	can	specify	inversion	on	a	per-line
basis.	Inversion	on	a	per-line	basis	is	a	method	of	scaling	the	digital	port
—converting	it	to	a	value	that	is	more	usable	for	you.
Any	values	read	from	or	written	to	the	line	or	port	are	inverted	according
to	the	Signal	Inversion	setting	before	being	written	or	after	being	read.



Duplicating	Virtual	Channels
To	copy	a	virtual	channel,	follow	these	steps:

1.	 Right-click	the	channel	you	want	to	copy	in	Data	Neighborhood
and	select	Duplicate.

2.	 Select	or	deselect	the	Increment	the	Channel	Number	box.
Incrementing	the	channel	number	is	not	valid	for	digital	channels
configured	to	read	from	or	write	to	a	port.

3.	 Enter	the	number	of	copies	you	want	to	make.
4.	 Click	OK.

MAX	copies	the	channel	the	specified	number	of	times	and	adds	them	to
the	list	of	channels	that	appears	in	Data	Neighborhood.



Testing	Virtual	Channels
To	use	the	Virtual	Channel	Test	Panels	to	view	actual	readings	or	to
directly	control	the	different	channels	you	have	configured,	follow	these
steps:

1.	 Right-click	a	channel	in	the	configuration	tree	and	select	Test.
2.	 From	here	you	can	select,	view,	and	test	the	following	channel

types:
	Analog	Input
	Analog	Output
	Digital	Input
	Digital	Output

3.	 Click	Close	when	you	are	done.
Note		Neither	DAQ	devices	running	in	LabVIEW	Real-Time	nor	the	PCI-7041	RT	Series	DAQ
device	currently	support	virtual	channel	testing.



Deleting	Virtual	Channels
To	delete	a	channel,	follow	these	steps:

1.	 Right-click	the	channel	you	want	to	delete	from	the	Data
Neighborhood.

2.	 Click	Delete.
3.	 A	dialog	box	opens	to	ask	if	you	are	sure	you	want	to	remove	the

selected	channel.	Click	Yes	to	remove	the	channel,	or	click	No	to
cancel	this	action.



Scales
Scales	displays	the	custom	scales	you	define	as	part	of	your	analog	input
or	output	virtual	channel	and	their	attributes.	From	Scales,	you	can
perform	the	following	tasks:

Create	a	new	custom	scale
Edit	a	custom	scale
Delete	a	custom	scale



Creating	Custom	Scales
To	create	a	custom	scale	for	an	analog	channel,	follow	these	steps:

1.	 In	the	Analog	Input	Configuration	or	Analog	Output	Configuration
windows,	select	the	New	Custom	Scale	option	in	the	Scaling
Formula	selection	box.	To	access	the	configuration	windows,
right-click	on	a	channel	in	the	configuration	tree	and	select
Properties.
You	also	can	launch	the	Create	New	Custom	Scale	Wizard	from
the	configuration	tree.	Right-click	Scales	in	the	configuration	tree
and	select	Create	New.	Select	NI-DAQ	Custom	Scale	and	click
Finish.

2.	 The	Create	New	Custom	Scale	Wizard	opens.	Enter	a	scale
name	and	description	in	the	Scale	Name	and	Scale	Description
selection	boxes.

3.	 Select	one	of	the	following	options	from	the	Scale	Type	selection
box,	and	click	Next.

Linear	Scale
Polynomial	Scale
Table	Scale



Creating	Linear	Scales
In	the	Create	New	Custom	Scale	wizard,	follow	these	steps:

1.	 Enter	the	scale	name	and	description.
2.	 Select	Linear	Scale	in	the	Scale	Type	selection	box	and	click

Next.
3.	 Enter	the	m	(slope)	and	b	(y-intercept)	values	in	the	selection

boxes.	Click	Next.
4.	 Verify	the	scale	plot.	If	it	is	not	correct,	click	Back	and	adjust	your

coefficient	values.
5.	 Adjust	the	raw	minimum	and	maximum	values,	if	necessary,	and

click	Apply.
6.	 Click	Finish	when	you	are	done.



Creating	Polynomial	Scales
In	the	Create	New	Custom	Scale	wizard,	follow	these	steps:

1.	 Enter	the	scale	name	and	description.
2.	 Select	Polynomial	Scale	in	the	Scale	Type	selection	box	and

click	Next.
3.	 In	the	Enter	Forward	Polynomial	Coefficients	dialog	box,	select

the	forward	coefficients	a0,	a1,	a2,...an	for	your	polynomial	scale:

y=a0+	a1x+	a2x2+…+anxn

where	y	is	the	scaled	data	and	x	is	the	raw	data.
a.	 In	the	coefficient	list	box,	select	the	coefficient	you	want	to

change	by	highlighting	the	corresponding	row	and	click
Change.	Specify	the	coefficient	in	the	Add	Coefficient
dialog	box	and	click	OK.

b.	 Click	Remove	to	remove	a	coefficient.	Click	Import	from
File	to	import	the	coefficients	from	a	spreadsheet	file.

c.	 Click	Next	to	continue.
4.	 In	the	Enter	Reverse	Polynomial	Coefficients	dialog	box,	select

the	reverse	coefficients	a0,	a1,	a2,...an	for	your	polynomial	scale:

x=a0+	a1y+	a2y2+…+anyn

where	y	is	the	scaled	data	and	x	is	the	raw	data.
a.	 To	enter	the	reverse	coefficients,	follow	the	same	steps	as

the	forward	coefficients,	or	click	Auto	Compute	and	MAX
automatically	estimates	the	reverse	coefficients	using
regression	analysis.	To	compute	reverse	coefficients,	enter
minimum	and	maximum	values	for	the	raw	range.	Enter	an
order	value.	Click	OK	to	calculate	reverse	coefficients.

b.	 Click	Next	to	continue.
5.	 Verify	the	scale	plot	in	the	Verify	Scale	dialog	box.	If	it	is	not

correct,	click	Back	and	adjust	your	coefficient	values.	Adjust	the
raw	minimum	and	maximum	values,	if	necessary,	and	click	Apply.

6.	 Click	Finish	when	you	are	done.



Creating	Table	Scales
In	the	Create	New	Custom	Scale	wizard,	follow	these	steps:

1.	 Enter	the	scale	name	and	description.
2.	 Select	Table	Scale	from	the	Scale	Type	selection	box	and	click

Next.
3.	 In	the	Enter	Table	Values	dialog	box,	click	Add	and	enter	the	raw

and	scaled	values	for	your	table	scale	entry.
To	modify	a	table	entry,	select	the	entry	in	the	table	list	box	and
click	Change.	To	remove	a	table	entry,	select	the	entry	and	click
Remove.
To	import	table	values	from	a	file,	click	Import	from	File.

4.	 Click	Next.
5.	 Verify	the	scale	plot	in	the	Verify	Scale	dialog	box.	If	it	is	not

correct,	click	Back	and	adjust	your	coefficient	values.	Adjust	the
raw	minimum	and	maximum	values,	if	necessary,	and	click	Apply.

6.	 Click	Finish	when	you	are	done.



Editing	Custom	Scales
To	edit	a	custom	scale	for	an	analog	channel,	follow	these	steps:

1.	 Expand	Scales	in	the	configuration	tree.
2.	 Right-click	the	scale	you	want	to	edit,	and	select	Properties.

–or–

Select	the	scale,	and	click	Properties	at	the	top	of	the	Attributes
pane.

3.	 The	Custom	Scale	Configuration	dialog	boxes	opens.	You	can
edit	the	following	settings:

Scale	Name
Description
Scale	Type

4.	 Click	OK	when	you	are	finished.



Editing	Scale	Name
To	edit	your	scale	name,	follow	these	steps:

1.	 Right-click	the	scale	in	the	configuration	tree	and	select
Properties.

2.	 Edit	the	text	in	the	Scale	Name	edit	box.
3.	 Click	OK.



Editing	Scale	Description
To	edit	the	scale	description,	follow	these	steps:

1.	 Right-click	the	scale	in	the	configuration	tree	and	select
Properties.

2.	 Edit	the	text	in	the	Description	edit	box.
3.	 Click	OK.



Editing	Scale	Type
1.	 Right-click	the	scale	and	select	Properties.
2.	 Select	one	of	the	following	options	from	the	selection	box.	Click

the	options	for	editing	information.	Each	scale	type	has	different
settings	to	configure.

Linear
Table
Polynomial



Editing	Linear	Scales
When	you	select	Linear	Scale	in	the	Scale	Type	dialog	box,	the	following
configurable	settings	are	displayed:
Linear
Coefficients

Enter	the	m	and	b	coefficients	for	the	y	=	mx	+	b	formula,	where	x	is	the	raw	value	read
from	the	sensor	or	output	to	the	actuator	in	sensor	or	actuator	units,	and	y	is	the	physical-
quantity	engineering	value.

Update
Plot

Click	this	button	to	view	your	scale	plot	with	the	new	coefficient	edits.



Editing	Table	Scales
When	you	select	Table	Scale	in	the	Scale	Type	dialog	box,	the	following
configurable	settings	are	displayed:
Table
Values

Click	Add	or	Change	to	enter	the	raw	and	scaled	(engineering	unit)	value	pairs.	This	table
scales	both	raw	sensor	value	to	physical	quantity	for	analog	input	and	physical	quantity	to	raw
actuator	value	for	analog	output.	Click	Remove	to	delete	a	raw	and	scaled	value	pair.

File Click	File	to	import	values	from	a	tab-	or	comma-delimited	spreadsheet	file.	Then	select	the
text	file	containing	the	table	lookup	values.	This	opens	the	Import	Table	Value	dialog	box.

Update
Plot

Click	Update	Plot	to	view	your	scale	plot	with	the	new	values.



Importing	Table	Values	from	a	File
Select	the	delimiter	used	in	your	text	file	(tab	is	the	default),	the	starting
row	and	ending	row,	and	the	column	numbers	for	the	Raw	and	Scaled
Values.	This	dialog	box	assumes	your	raw	and	scaled	values	are
contained	in	columns.	All	row	and	column	numbering	begins	at	1.	As	you
edit	the	column	and	row	numbers,	the	dialog	box	plots	the	points	it	reads
from	the	file.



Editing	Polynomial	Scales
When	you	select	Polynomial	Scale	in	the	Scale	Type	dialog	box,	the
following	configurable	settings	are	displayed:
Polynomial
Coefficients

Click	Change	button	to	enter	coefficients	for	each	polynomial	in	the	respective	input
control.	The	Polynomial	scale	displays	controls	for	both	the	forward	polynomial	(used	to
scale	from	the	raw	sensor	units	to	the	physical	engineering	unit)	and	the	reverse
polynomial	(used	to	scale	from	the	physical	engineering	unit	to	the	raw	sensor	units).
Select	the	View	Reverse	Coefficients	checkbox	to	view	the	reverse	coefficients.	Click
Remove	to	delete	a	coefficient.

File Click	File	to	import	values	from	a	tab-	or	comma-delimited	spreadsheet	file.	Then	select
the	text	file	containing	the	coefficient	values.	This	opens	the	Import	Polynomial
Coefficients	dialog	box.

Update
Plot

Click	Update	Plot	to	view	your	scale	plot	with	the	new	values.



Importing	Polynomial	Coefficients	from	a	File
Select	the	delimiter	used	in	your	text	file	(tab	is	selected	by	default),	the
starting	row	and	ending	row,	and	the	column	number	for	the	polynomial
coefficients.	For	this	dialog	box,	your	polynomial	coefficients	should	be
contained	in	columns.	All	row	and	column	numbering	begins	at	1.	As	you
edit	the	column	and	row	numbers,	the	dialog	box	plots	the	points	it	reads
from	the	file.



Deleting	Custom	Scales
To	delete	a	scale,	follow	these	steps:

1.	 Right-click	the	scale	you	want	to	delete	from	the	configuration
tree.

2.	 Click	Delete.
3.	 A	dialog	box	opens	to	ask	if	you	are	sure	you	want	to	remove	the

selected	scale.	Click	Yes	to	remove	the	scale,	or	click	No	to
cancel	this	action.



Operating	System	Considerations
Special	considerations	exist	for	the	following	operating	systems:

Windows	2000/XP
Windows	NT



Special	Considerations	for	Windows	2000/XP
Devices
The	Windows	2000/XP	Device	Manager	manages	all	hardware	devices
in	your	computer	system.	However,	the	Windows	2000/XP	operating
system	may	not	automatically	detect	all	DAQ	devices.	For	information	on
adding	or	configuring	specific	DAQ	devices,	refer	to	the	following	topics:

Plug	and	Play	Devices
PCI	and	PXI	Devices
AT	E	Series	Devices



Computers
For	special	device	information	on	EISA	bus	computers,	refer	to	EISA	Bus
Computers.



Windows	2000/XP	Device	Manager
The	Device	Manager	allocates	system	resources	for	all	devices	you	have
in	the	system	and	makes	sure	no	two	devices	are	using	the	same	system
resources	such	as	base	address	or	interrupt	level.	In	Windows	2000/XP,
you	open	the	Device	Manager	by	expanding	Start»Settings»Control
Panel»System,	and	then	selecting	the	Hardware	tab.	Click	Device
Manager.
The	Device	Manager	detects	Plug	and	Play	devices	when	your	system
starts	and	automatically	assigns	resources	for	your	device.	For	more
information,	refer	to	Plug	and	Play	Devices.
You	can	also	change	system	resources	for	your	DAQ	device	using	the
Device	Manager.	For	more	information,	refer	to	Resource	Allocation.



Plug	and	Play	Devices
If	you	have	installed	your	Plug	and	Play	DAQ	device	before	installing	NI-
DAQ,	or	if	MAX	did	not	automatically	detect	your	device,	follow	these
steps:

1.	 Go	to	Start»Settings»Control	Panel»System,	and	select	the
Hardware	tab.

2.	 Click	Device	Manager.
3.	 Select	a	National	Instruments	DAQ	device	under	Other	Devices

in	the	device	type	list.	Right-click	the	device	and	select	Uninstall.
Repeat	with	each	National	Instruments	device	in	the	list.

4.	 Right-click	in	the	Device	Manager	window	and	select	Scan	for
hardware	changes.	Windows	2000/XP	detects	Plug	and	Play
device(s).

5.	 Click	OK	when	you	are	finished.
If	you	have	not	yet	installed	the	Plug	and	Play	DAQ	device,	power	off
your	computer	and	install	the	device.	Power	on	the	computer	after
installation	is	complete.	When	Windows	2000/XP	starts	up,	it	should
assign	resources	to	the	device	automatically.
If	Windows	2000/XP	does	not	detect	the	Plug	and	Play	device,	refer	to
ni.com/support	for	troubleshooting	help.
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PCI	and	PXI	Devices
PCI	and	PXI	DAQ	devices	are	Plug	and	Play	devices;	however,	because
of	the	PCI	bus	architecture,	there	are	some	differences	in	how	you	must
configure	these	devices	as	compared	to	ISA	Plug	and	Play	devices.	You
generally	cannot	modify	any	system	resources	for	PCI	and	PXI	DAQ
devices.	In	Windows	2000,	you	can	modify	the	Memory	Window	only	by
using	the	Device	Manager.	Refer	to	Resource	Allocation	for	more
information.



AT	E	Series	Devices
The	following	topics	discuss	special	considerations	for	AT	E	Series
devices	in	Windows	2000/XP.
Resource	Allocation	for	AT	E	Series	Devices
Distributing	DMA	Channels	among	Multiple	Devices
Freeing	All	DMA	Channels	from	an	AT	E	Series	Device



Resource	Allocation	for	AT	E	Series	Devices
To	change	or	view	the	allocation	of	I/O	space,	interrupts,	and	DMA	for
your	AT	E	Series	device	in	Windows	2000/XP,	follow	these	steps:

1.	 In	Windows	2000/XP,	open	the	Device	Manager	by	going	to
Start»Settings»Control	Panel»System.	In	the	System
Properties	window,	select	the	Hardware	tab.	Click	Device
Manager.

2.	 Expand	Data	Acquisition	Devices	to	see	a	list	of	installed	DAQ
devices.	You	will	see	two	entries	for	each	AT	E	Series	device,
distinguished	by	the	suffix	Logical	Device	(1	of	2)	and	Logical
Device	(2	of	2).	This	is	due	to	a	Plug	and	Play	limitation.

3.	 Select	the	first	logical	device,	and	click	Properties.	In	the	Device
Properties	window,	select	the	Resources	tab.	Next	to	the	field
labeled	Setting	based	on,	there	is	a	drop-down	box	of	Basic
Configurations	as	follows:

Basic	configuration	0000	(Base	address,	one	IRQ,	two
DMA)
Basic	configuration	0001	(Base	address,	one	IRQ,	one
DMA)
Basic	configuration	0002	(Base	address,	one	IRQ)
Basic	configuration	0003	(Base	address	only)

If	you	do	not	see	the	last	entry	for	Base	address	only,	your	device
has	an	older	version	of	the	EEPROM,	which	you	can	update.

4.	 You	can	select	from	the	Basic	Configurations	offered	to	reduce
the	number	of	DMA	channels	your	device	will	use	or	to	configure
the	device	to	have	Base	address	only.

5.	 If	you	view	the	resources	for	your	second	logical	device,	there	is
only	one	logical	configuration:

Basic	configuration	0000	(DMA)
If	a	DMA	channel	was	not	available	for	your	second	logical	device,
you	will	see	no	entries	in	the	Resource	Settings	box.	There	are	no
other	options	besides	Basic	configuration	0000.	To	free	the	DMA
channel	that	has	been	assigned	to	the	second	logical	device,	refer
to	Distributing	DMA	Channels	among	Multiple	Devices	and



Freeing	All	DMA	Channels	from	an	AT	E	Series	Device.
6.	 Click	OK	when	you	are	done	to	close	the	Device	Properties

window.	Then	click	OK	to	close	the	System	Properties	window.



Distributing	DMA	Channels	among	Multiple	Devices
If	you	have	more	than	one	AT	E	Series	device,	the	first	device	that
Windows	2000/XP	configures	may	receive	all	available	DMA	channels,
allocating	none	to	the	second	device.
To	free	one	or	two	of	the	DMA	channels	allocated	to	Logical	Device	1	of
the	first	device,	choose	Basic	configuration	0001	or	0002.	Each
configuration	allocates	one	or	no	DMA	channels,	respectively.	One	or	two
DMA	channels	are	now	free	for	other	devices.
To	allocate	the	available	DMA	channels	to	a	second	AT	E	Series	device,
do	one	of	the	following:

Restart	your	computer.
Remove	the	second	device	from	the	Device	Manager.	In	Windows
2000/XP,	right-click	any	device	in	the	Device	Manager	window	and
select	Scan	for	hardware	changes.	The	Device	Manager	detects
the	second	device	again	and	allocates	resources	to	it.

If	Logical	Device	2	of	your	first	device	was	allocated	a	DMA	channel,	your
first	device	now	has	one	or	two	DMA	channels	available	to	use,
depending	on	which	Basic	configuration	you	chose	for	Logical	Device	1.
To	free	the	DMA	channel	allocated	to	Logical	Device	2,	refer	to	Freeing
All	DMA	Channels	from	an	AT	E	Series	Device.



Freeing	All	DMA	Channels	from	an	AT	E	Series	Device
If	you	want	your	AT	E	Series	device	to	use	interrupts	only,	although	the
device	has	DMA	channels	allocated	to	it,	call	the	NI-DAQ	function
Set_DAQ_Device_Info	(or	the	LabVIEW	Set	DAQ	Device	Information	VI)
and	change	the	transfer	mode	to	Interrupts	Only.	Alternately,	you	can	use
the	Device	Manager	to	remove	all	the	DMA	channels	allocated	to	an	AT
E	Series	device.	Follow	these	steps	to	free	DMA	channels	in	Windows
2000/XP:

1.	 In	Windows	2000/XP,	open	the	Device	Manager	by	going	to
Start»Settings»Control	Panel»System.	In	the	System
Properties	window,	select	the	Hardware	tab.	Click	Device
Manager.

2.	 Expand	Data	Acquisition	Devices	to	see	a	list	of	installed	DAQ
devices.	You	will	see	two	entries	for	each	AT	E	Series	device,
distinguished	by	the	suffix	Logical	Device	(1	of	2)	and	Logical
Device	(2	of	2).	This	is	due	to	a	Plug	and	Play	limitation.

3.	 Select	the	first	logical	device,	and	click	Properties.	In	the	Device
Properties	window,	select	the	Resources	tab.	Next	to	the	field
labeled	"Setting	based	on,"	select	basic	configuration	0002	or
0003	for	the	first	logical	device	to	take	away	both	of	its	DMA
channels.

4.	 To	remove	the	DMA	channel	assigned	to	the	second	logical
device,	deselect	the	second	logical	device	under	the	Device
Usage	section	in	the	lower	left-hand	corner	of	the	General	tab.
Restart	your	computer.

5.	 The	next	time	you	run	MAX,	you	should	see	no	DMA	channels
associated	with	your	device.	If	this	does	not	work	(even	though
the	second	logical	device	is	disabled,	Windows	2000/XP
sometimes	reports	that	it	has	a	DMA	channel	allocated	to	it),	try
one	of	the	following	two	approaches:

The	easiest	approach	is	to	reserve	resources	in	the
Computer	Properties	page	for	your	computer.	Access	this
by	right-clicking	the	Computer	icon	in	the	Device	Manager
and	selecting	Properties.	When	the	Computer	Properties
box	opens,	select	the	Direct	Memory	Access	(DMA)



option	and	then	the	Reserve	Resources	tab.	If	you	have
an	ISA	bus	computer	and	do	not	want	an	AT	E	Series
device	to	be	assigned	any	DMA	resources,	reserve	any	of
the	channels	5,	6,	and	7	that	are	not	already	in	use	by
some	other	device.
Another	approach	is	to	make	sure	that	other	devices	are
assigned	all	of	your	available	DMA	channels	before	your	AT
E	Series	device.	If	you	have	other	hardware	that	needs
DMA	channels,	you	can	install	that	hardware	first.	If	your	AT
E	Series	device	has	already	been	installed,	you	can	remove
it	from	the	Device	Manager	and	refresh	again	after	your
other	hardware	has	been	added.

If	you	have	an	AT	E	Series	device	and	an	EISA	bus	computer,	refer	to
EISA	Bus	Computers.



Resource	Allocation
The	Windows	2000/XP	operating	system	handles	the	allocation	of
system	resources	such	as	I/O	space,	IRQ,	and	DMA.	To	view	or	change
the	allocation	of	I/O	space,	IRQ,	and	DMA	for	your	DAQ	device,	follow
these	steps:

1.	 Open	the	Device	Manager	by	selecting	Start»Settings»Control
Panel»System.	Select	the	Hardware	tab.	Click	Device	Manager.

2.	 Double-click	Data	Acquisition	Devices	for	a	list	of	installed	DAQ
devices.



Viewing	Allocated	Resources
To	view	the	properties	for	a	device	in	the	Device	Manager,	double-click
that	device,	then	select	the	Resources	tab.	This	tab	shows	the	resources
allocated	to	your	device.
The	Setting	based	on	selection	box	shows	basic	configurations.	Each	of
these	basic	configurations	contains	a	list	of	valid	resources	that	the
device	can	use.	Typically,	Basic	configuration	0000	contains	all	resources
a	device	could	possibly	need.	Each	subsequent	configuration	contains	a
subset	of	the	desired	resources.	The	following	are	the	basic
configurations.

Basic	configuration	0000	(Base	address,	one	IRQ,	two	DMA)
Basic	configuration	0001	(Base	address,	one	IRQ,	one	DMA)
Basic	configuration	0002	(Base	address,	one	IRQ)
Basic	configuration	0003	(Base	address	only)

For	non-Plug	and	Play	DAQ	Devices,	these	configurations	are	described
in	the	nidaq.inf	and	the	nidaq1.inf	files	in	your	Windows\Inf	directory.	For
Plug	and	Play	DAQ	Devices,	including	PC	Cards	(PCMCIA),	the
configurations	are	stored	on	the	onboard	EEPROM,	which	is	read	by
Windows	2000/XP.



Changing	Allocated	Resources
To	change	the	resources	assigned	to	a	device,	follow	these	steps:

1.	 Deselect	the	Use	Automatic	Settings	box.
2.	 Select	a	resource,	and	click	Change	Setting.
3.	 A	window	opens	with	settings	you	can	change.	Click	OK	when

you	are	done.	Windows	2000/XP	may	prompt	you	to	restart	your
computer	for	the	changes	to	take	effect.

For	additional	information	on	changing	resources	for	AT	E	Series
devices,	see	EISA	Bus	Computer	Considerations:	AT	E	Series	Devices.



EISA	Bus	Computers
The	following	devices	use	specific	DMA	channels	on	EISA	bus
computers.
AT	E	Series	Devices



EISA	Bus	Computer	Considerations:	AT	E	Series	Devices
AT	E	Series	devices	manufactured	before	December	1995	have	a	Plug
and	Play	EEPROM	programmed	to	request	three	16-bit	DMA	channels
(from	channels	0,	1,	2,	3,	5,	6,	and	7).	For	AT	E	Series	devices
manufactured	after	December	1995,	the	EEPROM	requests	only	DMA
channels	5,	6,	and	7.
If	you	have	an	EISA	bus	computer	and	want	to	use	DMA	channels	0,	1,	2,
or	3	with	your	newer	AT	E	Series	device,	you	need	to	run	the	E	Series
EEPROM	Update	Utility.	For	more	information,	refer	to	Updating	Your	AT
E	Series	EEPROM.



Updating	Your	AT	E	Series	EEPROM
If	you	have	an	AT	E	Series	device	shipped	prior	to	December	1995,	you
should	run	the	EEUPDATE	Utility	to	update	your	EEPROM	contents	to
match	those	of	current	AT	E	Series	devices.
You	can	fix	the	following	problems	with	the	EEUPDATE	Utility.

The	configuration	manager	or	PnP	BIOS	in	your	computer	assigns
the	DMA	level	for	the	floppy	drive	to	your	AT	E	Series	device.	This
typically	results	in	a	floppy	drive	failure	during	power-up	with	your
AT	E	Series	device	in	the	computer.
Solution—Start	your	computer	without	the	floppy	drive	support,
then	run	the	EEUPDATE	Utility	and	reprogram	the	EEPROM	with
the	Default	ISA	option.

Note		The	EEUPDATE	program	must	already	reside	on	your
hard	drive	for	this	solution	to	work.	If	the	EEUPDATE	Utility
is	not	already	installed	on	your	hard	drive,	install	it	before
disabling	your	floppy	drive.

Your	ISA	bus	computer	has	an	EISA	DMA	controller,	which	can
cause	the	Plug	and	Play	BIOS	of	your	computer	to	assign	the
device	some	of	the	lower	DMA	channels:	0,	1,	2,	or	3.	NI-DAQ
cannot	use	these	DMA	channels.
Solution—Run	the	EEUPDATE	Utility	and	reprogram	the
EEPROM	with	the	Default	ISA	option.
The	first	logical	device	of	an	AT	E	Series	device	has	only	three
basic	configurations	associated	with	it	instead	of	four.	The	fourth
basic	configuration	assigns	the	device	only	a	base	address,	with
no	DMA	or	IRQ	resources.
Solution—Run	the	EEUPDATE	Utility	and	reprogram	the
EEPROM	with	the	Default	ISA	option	or	Default	EISA	option,
depending	on	the	bus	type	of	your	computer.
The	AT	E	Series	device	is	installed	in	an	EISA	bus	machine	and
you	want	to	use	DMA	0,	1,	2,	or	3.	(Devices	manufactured	after
December	1995	were	factory-configured	in	a	Default	ISA	mode,
and	the	device	will	not	request	DMA	channels	0,	1,	2,	or	3).



Solution—Run	the	EEUPDATE	Utility	and	reprogram	the
EEPROM	with	the	Default	EISA	option.
Your	AT	E	Series	device	is	configured	for	an	EISA	bus	computer,
but	you	now	want	to	use	it	in	an	ISA	bus	computer.	(Devices
manufactured	prior	to	December	1995	were	factory-configured	in	a
Default	EISA	mode.)
Solution—A	custom	configuration	option	is	available,	but	you
should	not	run	this	option	without	first	consulting	an	applications
engineer	at	National	Instruments.

If	you	need	to	update	the	EEPROM	on	your	AT	E	Series	device,
download	the	file	eeupdate.zip	from	the	Web	site.
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MAX	Registry	Entries
MAX	and	its	associated	Windows	2000/XP	drivers	and	DLLs	modify	the
Windows	registry	to	keep	track	of	the	devices	you	have	installed	and
configured.
The	NI-DAQ	installer	makes	its	own	entries	in	the	Windows	2000/XP
registry,	and	you	can	remove	them	by	uninstalling	NI-DAQ.	You	can
uninstall	NI-DAQ	using	the	Control	Panel»Add/Remove	Programs
wizard.



Modified	Registry	Entry
MAX	modifies	the	following	place	in	the	Windows	2000/XP	registry:
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Class\DAQDevice\nnnn
where	nnnn	is	a	four-digit	hexadecimal	number.



Added	Registry	Entries
The	Windows	Device	Manager	adds	the	following	registry	entries	when	it
detects	NI	Plug	and	Play	hardware	or	when	you	add	new	hardware	using
the	Add	New	Hardware	wizard:
HKEY_LOCAL_MACHINE\Enum\ISAPNP\NICnnnn,	where	nnnn	is	a	four-
digit	hexadecimal	number.
HKEY_LOCAL_MACHINE\Enum\PCI\VEN_1093&DEV_nnnn,	where	nnnn
is	a	four-digit	hexadecimal	number.
HKEY_LOCAL_MACHINE\Enum\PCMCIA\National_Instruments-
DAQCARD*,	where	*	consists	of	the	rest	of	the	product	name,	plus	a
four-digit	hexadecimal	CRC	code.
HKEY_LOCAL_MACHINE\Enum\Root\DAQDevice
To	view	these	registry	entries	in	the	Windows	2000/XP	Registry	Editor,
select	Start»Run	and	enter	regedt32.exe.	This	runs	the	Registry	Editor
program.



Removing	NI-DAQ	Configuration	Information	in	Windows
2000/XP
Deleting	an	NI-DAQ	configuration	file	(default:	Niconfig.daq)	in	your
Windows	directory	will	delete	all	SCXI	configuration	information	as	well	as
your	analog	input	and	analog	output	settings.	The	next	time	you	run
MAX,	your	devices	will	reappear,	but	the	configuration	information	will	be
lost.	You	do	not	need	to	restart	your	computer	after	deleting	the	NI-DAQ
configuration	file.
To	remove	your	NI-DAQ	configuration,	follow	these	steps:

1.	 Delete	the	NI-DAQ	configuration	file	(default:	Niconfig.daq)	in	your
Windows	directory.

2.	 In	Windows	2000/XP,	open	the	Device	Manager	by	selecting
Start»Settings»Control	Panel»System.	Select	the	Hardware
tab	and	click	Device	Manager.

3.	 From	the	Device	Manager,	remove	all	National	Instruments	DAQ
devices	by	selecting	each	device	and	clicking	Uninstall.	In
Windows	2000/XP,	if	there	are	any	National	Instruments	devices
in	the	Other	Devices	category,	remove	those	devices	as	well.

4.	 Click	OK.
5.	 Restart	your	computer.

The	preceding	steps	remove	the	association	between	DAQ	devices	and
NI-DAQ	device	numbers,	and	force	Windows	2000/XP	to	reconfigure
your	Plug	and	Play	devices.	You	must	also	reconfigure	your	non-Plug
and	Play	devices.



Special	Considerations	for	Windows	NT	Devices
There	are	some	special	considerations	when	adding	certain	DAQ	devices
in	Windows	NT.	For	information	on	adding	or	configuring	specific	DAQ
devices,	refer	to	Plug	and	Play	Devices.



Plug	and	Play	Devices	in	Windows	NT
For	information	on	special	considerations	for	Plug	and	Play	devices	in
Windows	NT,	select	any	of	the	following	topics:

ISA	Devices
PC	Card	Devices
PCI	Devices



ISA	Devices
If	you	plan	to	use	ISA	Plug	and	Play	DAQ	devices	on	Windows	NT,	you
must	first	install	NI-DAQ,	then	the	Windows	NT	ISA	Plug	and	Play	driver
before	configuring	your	device	with	MAX.	This	driver	is	not	installed	by
default.	Follow	these	steps	to	install	the	driver:

1.	 Insert	your	Windows	NT	CD.
2.	 Go	to	the	\Drvlib\Pnpisa\X86	directory.
3.	 Right-click	the	Pnpisa.inf	file	and	select	Install.
4.	 After	you	have	installed	the	Pnpisa.inf	file,	power	off	your

computer.
5.	 Install	your	ISA	Plug	and	Play	DAQ	device.
6.	 Power	on	your	computer.	When	Windows	NT	detects	your	ISA

Plug	and	Play	DAQ	device,	it	will	specify	the	necessary	driver
files.	Because	this	will	result	in	a	configuration	change,	restart
your	computer.

7.	 After	restarting,	run	MAX.	MAX	will	automatically	detect	the
device	and	ask	for	a	device	number.

Refer	to	Configuring	DAQ	Devices	for	more	information.
Note		After	you	make	any	resource	changes	to	ISA	Plug	and	Play	devices	in	MAX,	you	must
restart	your	system.



PC	Card	Devices	(PCMCIA)
To	change	the	socket	your	PC	Card	device	resides	in,	select	a	PC	Card
socket	in	the	System	Resources.
You	must	add	the	device	and	assign	resources	manually	to	the	PC	Card
device.	To	find	out	what	resources	are	available	to	your	computer,	run	the
Windows	NT	Diagnostics	Utility	by	going	to
Start»Programs»Administrative	Tools	(Common)»Windows	NT
Diagnostics	and	clicking	the	Resources	tab.

Note		After	you	make	any	resource	changes	to	PC	Card	devices	in	MAX,	you	must	restart	your
system.



PCI	Devices
PCI	DAQ	devices	are	Plug	and	Play	devices;	however,	because	of	the
influence	of	the	PCI	bus	architecture,	there	are	some	differences	in	how
you	must	configure	your	PCI	device,	as	compared	to	ISA	Plug	and	Play
devices.	You	generally	cannot	modify	any	system	resources	for	PCI	DAQ
devices,	since	under	Windows	NT,	MAX	uses	the	BIOS-assigned
resources.
Although	assigned	resources	cannot	be	modified,	follow	these	steps	to
verify	resources:

1.	 Right-click	the	device	in	the	configuration	tree.
2.	 Select	Test	Panel.

Test	panels	test	the	device	and	make	sure	the	assigned	system
resources	are	correct.



Reserving	More	Acquisition	Memory
Windows	NT	limits	the	total	amount	of	memory	that	is	page	locked.	The
default	amount	of	memory	is	determined	according	to	the	total	amount	of
physical	memory	available	in	your	system.	If	you	are	working	with	large
data	acquisition	buffers,	you	might	encounter	an	outOfMemoryError,
unless	you	increase	the	default	I/O	page	lock	limit	using	the	Windows	NT
Registry	Editor,	regedt32.exe.
The	IoPageLockLimit	registry	key	is	located	in:
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Session
Manager\Memory	Management
By	default,	this	limit	is	0,	which	indicates	to	the	system	that	it	should	use
a	built-in	algorithm	to	determine	the	amount	of	available	memory.	You
can	change	this	value	to	indicate	the	number	of	bytes	that	can	be	used.

Caution		Use	caution	when	changing	this	value.	The	default	value	computed	by	the	system
when	IoPageLockLimit	equals	0	is	tuned	specifically	for	system	performance.	Allowing	the
system	to	lock	down	more	memory	can	have	a	detrimental	effect	on	system	performance	and
can	even	render	your	machine	unusable.



Removing	NI-DAQ	Configuration	Information	in	Windows
NT
To	remove	your	NI-DAQ	configuration,	follow	these	steps:

1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Remove	each	configured	device	by	right-clicking	the	device	and

selecting	Delete.
3.	 Save	your	changes	and	exit	MAX.
4.	 Delete	the	NI-DAQ	configuration	file	(default:	Niconfig.daq)	in	your

Windows	directory.



Glossary
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A

address Character	code	that	identifies	a	specific	location	(or	series	of	locations)	in	memory.



B

base
address

A	memory	address	that	serves	as	the	starting	address	for	programmable	registers.	All	other
addresses	are	located	by	adding	to	the	base	address.

BIOS Basic	Input/Output	System—BIOS	functions	are	the	fundamental	level	of	any	PC	or
compatible	computer.	BIOS	functions	embody	the	basic	operations	needed	for	successful	use
of	the	computer	hardware	resources.

bus The	group	of	conductors	that	interconnect	individual	circuitry	in	a	computer.	Typically,	a	bus	is
the	expansion	vehicle	to	which	I/O	or	other	devices	are	connected.	Examples	of	PC	buses	are
the	ISA	and	PCI	bus.



C

channel 1.	 Physical—A	terminal	where	an	analog	or	digital	signal	may	be	input	or	output.
A	single	physical	channel	can	imply	more	than	one	terminal	as	in	the	case	of	a
differential	analog	input	channel	or	a	digital	port	of	eight	lines.

2.	 Virtual—A	collection	of	property	settings	that	includes	a	physical	channel,	type
of	measurement	or	generation,	and	scaling	information.

configuration
tree

Refers	to	the	left	window	in	Measurement	&	Automation	Explorer,	which	contains	items
such	as	Data	Neighborhood	and	Devices	and	Interfaces.



D

DAQ 1.	 Data	AcQuisition.
2.	 Collecting	and	measuring	electrical	signals	from	sensors,	transducers,	and	test

probes	or	fixtures	and	inputting	them	to	a	computer	for	processing.
3.	 Collecting	and	measuring	the	same	kinds	of	electrical	signals	with	A/D	and/or	DIO

devices	plugged	into	a	computer,	and	possibly	generating	control	signals	with	D/A
and/or	DIO	devices	in	the	same	computer.

device 1.	 An	instrument	or	controller	that	can	be	addressed	as	a	single	entity	and	controls	or
monitors	real-world	I/O	points.	A	device	often	is	connected	to	the	host	computer
through	some	type	of	communication	network,	or	can	be	a	plug-in	device.

2.	 DAQ.	A	plug-in	data	acquisition	device,	card,	or	pad	that	can	contain	multiple
channels	and	conversion	devices.	Plug-in	devices	and	PCMCIA	cards	are	all
examples	of	DAQ	devices.	SCXI	modules	are	distinct	from	DAQ	devices.

DIO digital	input/output

driver Software	that	controls	a	specific	hardware	device	such	as	a	DAQ	device.

drop-
down
listbox

A	graphical	box	with	a	down	arrow	button	that	lets	you	select	values	or	options	from	a	list.	To
select	a	value	or	option	in	the	selection	box,	click	the	down	arrow	for	a	complete	list	of	values
or	options,	then	use	your	arrow	keys	or	mouse	to	select	a	value	or	option	from	the	list.



G

gain The	factor	by	which	a	signal	is	amplified,	sometimes	expressed	in	decibels	(dB).



H

hardware The	physical	components	of	a	computer	system,	such	as	the	circuit	boards,	plug-in	boards,
chassis,	enclosures,	peripherals,	and	cables.

hex Hexadecimal;	a	base-16	numbering	system.



I

interrupt A	computer	signal	indicating	that	the	CPU	should	suspend	its	current	task	to	service	a
designated	activity.

interrupt
level

The	relative	priority	at	which	a	device	can	interrupt.

I/O input/output—the	transfer	of	data	to/from	a	computer	system	involving	communications
channels,	operator	interface	devices,	and/or	data	acquisition	and	control	interfaces.

IRQ Interrupt	ReQuest

ISA industry	standard	architecture.	Also	refers	to	a	common	PC	expansion	bus.



M

MAX Measurement	&	Automation	Explorer.

multiplexed
mode

An	SCXI	operating	mode	in	which	analog	input	channels	are	multiplexed	into	one	module
output	so	that	the	cabled	DAQ	device	has	access	to	the	multiplexed	output	as	well	as	the
outputs	on	all	other	multiplexed	modules	in	the	chassis	through	the	SCXI	bus.	Also	called
serial	mode.



N

NI-DAQ National	Instruments	driver	software	for	DAQ	hardware.



O

OLE object	linking	and	embedding

OPC OLE	for	process	control.

operating
system

Base-level	software	that	controls	a	computer,	runs	programs,	interacts	with	users,	and
communicates	with	installed	hardware	or	peripheral	devices.	Also	referred	to	as	OS.



P

PCI Peripheral	Component	Interconnect—a	high-performance	expansion	bus	architecture
originally	developed	by	Intel	to	replace	ISA	and	EISA.	PCI	offers	a	theoretical	maximum
transfer	rate	of	132	Mbytes/s.

PCMCIA An	expansion	bus	architecture	that	has	found	widespread	acceptance	as	a	de	facto	standard
in	notebook-size	computers.	PCMCIA	originated	as	a	specification	for	add-on	memory	cards
written	by	the	Personal	Computer	Memory	Card	International	Association.

Plug
and	Play
devices

Devices	that	do	not	require	DIP	switches	or	jumpers	to	configure	resources	on	the	devices.
Also	called	switchless	devices.



R

RDA remote	device	access—A	protocol	used	in	NI-DAQ	to	transparently	establish	communication,
configure,	and	acquire	data	on	the	remote	device	over	a	local	area	network	or	the	Internet.

RT Real-Time—a	property	of	an	event	or	system	in	which	data	is	processed	as	it	is	acquired
instead	of	being	accumulated	and	processed	at	a	later	time.

RT
Series

Processor-based	DAQ	devices	for	use	with	the	LabVIEW	Real-Time	module.



S

SCXI Signal	Conditioning	eXtensions	for	Instrumentation—the	National	Instruments	product	line	for
conditioning	low-level	signals	within	an	external	chassis	near	sensors	so	only	high-level	signals
are	sent	to	DAQ	devices	in	the	noisy	PC	environment.

sensor A	device	that	responds	to	a	physical	stimulus	(heat,	light,	sound,	pressure,	motion,	flow,	and	so
on),	and	produces	a	corresponding	electrical	signal.



T

task A	channel	or	group	of	channels	with	the	same	timing	and	triggering.
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Warranty
The	media	on	which	you	receive	National	Instruments	software	are
warranted	not	to	fail	to	execute	programming	instructions,	due	to	defects
in	materials	and	workmanship,	for	a	period	of	90	days	from	date	of
shipment,	as	evidenced	by	receipts	or	other	documentation.	National
Instruments	will,	at	its	option,	repair	or	replace	software	media	that	do	not
execute	programming	instructions	if	National	Instruments	receives	notice
of	such	defects	during	the	warranty	period.	National	Instruments	does	not
warrant	that	the	operation	of	the	software	shall	be	uninterrupted	or	error
free.
A	Return	Material	Authorization	(RMA)	number	must	be	obtained	from
the	factory	and	clearly	marked	on	the	outside	of	the	package	before	any
equipment	will	be	accepted	for	warranty	work.	National	Instruments	will
pay	the	shipping	costs	of	returning	to	the	owner	parts	which	are	covered
by	warranty.
National	Instruments	believes	that	the	information	in	this	document	is
accurate.	The	document	has	been	carefully	reviewed	for	technical
accuracy.	In	the	event	that	technical	or	typographical	errors	exist,
National	Instruments	reserves	the	right	to	make	changes	to	subsequent
editions	of	this	document	without	prior	notice	to	holders	of	this	edition.
The	reader	should	consult	National	Instruments	if	errors	are	suspected.
In	no	event	shall	National	Instruments	be	liable	for	any	damages	arising
out	of	or	related	to	this	document	or	the	information	contained	in	it.
Except	as	specified	herein,	National	Instruments	makes	no
warranties,	express	or	implied,	and	specifically	disclaims	any
warranty	of	merchantability	or	fitness	for	a	particular	purpose.
Customer's	right	to	recover	damages	caused	by	fault	or	negligence
on	the	part	of	National	Instruments	shall	be	limited	to	the	amount
theretofore	paid	by	the	customer.	National	Instruments	will	not	be
liable	for	damages	resulting	from	loss	of	data,	profits,	use	of
products,	or	incidental	or	consequential	damages,	even	if	advised
of	the	possibility	thereof.	This	limitation	of	the	liability	of	National
Instruments	will	apply	regardless	of	the	form	of	action,	whether	in
contract	or	tort,	including	negligence.	Any	action	against	National
Instruments	must	be	brought	within	one	year	after	the	cause	of	action



accrues.	National	Instruments	shall	not	be	liable	for	any	delay	in
performance	due	to	causes	beyond	its	reasonable	control.	The	warranty
provided	herein	does	not	cover	damages,	defects,	malfunctions,	or
service	failures	caused	by	owner's	failure	to	follow	the	National
Instruments	installation,	operation,	or	maintenance	instructions;	owner's
modification	of	the	product;	owner's	abuse,	misuse,	or	negligent	acts;
and	power	failure	or	surges,	fire,	flood,	accident,	actions	of	third	parties,
or	other	events	outside	reasonable	control.



Copyright
Under	the	copyright	laws,	this	publication	may	not	be	reproduced	or
transmitted	in	any	form,	electronic	or	mechanical,	including	photocopying,
recording,	storing	in	an	information	retrieval	system,	or	translating,	in
whole	or	in	part,	without	the	prior	written	consent	of	National	Instruments
Corporation.



Patents
For	patents	covering	National	Instruments	products,	refer	to	the
appropriate	location:	Help»Patents	in	your	software,	the	patents.txt	file	on
your	CD,	or	ni.com/patents

javascript:WWW(WWW_Patents)


Trademarks
National	Instruments,	NI,	ni.com,	and	LabVIEW	are	trademarks	of
National	Instruments	Corporation.	Refer	to	the	Terms	of	Use	section	on
ni.com/legal	for	more	information	about	National	Instruments	trademarks.
FireWire®	is	the	registered	trademark	of	Apple	Computer,	Inc.
Handle	Graphics®,	MATLAB®,	Real-Time	Workshop®,	Simulink®,	and
Stateflow®	are	registered	trademarks,	and	TargetBox2™,	xPC
TargetBox2™,	and	Target	Language	Compiler™	are	trademarks	of	The
MathWorks,	Inc.
Tektronix®	and	Tek	are	registered	trademarks	of	Tektronix,	Inc.
Other	product	and	company	names	mentioned	herein	are	trademarks	or
trade	names	of	their	respective	companies.
Members	of	the	National	Instruments	Alliance	Partner	Program	are
business	entities	independent	from	National	Instruments	and	have	no
agency,	partnership,	or	joint-venture	relationship	with	National
Instruments.

javascript:WWW(WWW_Trademark)


WARNING	REGARDING	USE	OF	NATIONAL	INSTRUMENTS
PRODUCTS
(1)	National	Instruments	products	are	not	designed	with
components	and	testing	for	a	level	of	reliability	suitable	for	use	in	or
in	connection	with	surgical	implants	or	as	critical	components	in
any	life	support	systems	whose	failure	to	perform	can	reasonably
be	expected	to	cause	significant	injury	to	a	human.
(2)	In	any	application,	including	the	above,	reliability	of	operation	of
the	software	products	can	be	impaired	by	adverse	factors,	including
but	not	limited	to	fluctuations	in	electrical	power	supply,	computer
hardware	malfunctions,	computer	operating	system	software
fitness,	fitness	of	compilers	and	development	software	used	to
develop	an	application,	installation	errors,	software	and	hardware
compatibility	problems,	malfunctions	or	failures	of	electronic
monitoring	or	control	devices,	transient	failures	of	electronic
systems	(hardware	and/or	software),	unanticipated	uses	or
misuses,	or	errors	on	the	part	of	the	user	or	applications	designer
(adverse	factors	such	as	these	are	hereafter	collectively	termed
"system	failures").	Any	application	where	a	system	failure	would
create	a	risk	of	harm	to	property	or	persons	(including	the	risk	of
bodily	injury	and	death)	should	not	be	reliant	solely	upon	one	form
of	electronic	system	due	to	the	risk	of	system	failure.	To	avoid
damage,	injury,	or	death,	the	user	or	application	designer	must	take
reasonably	prudent	steps	to	protect	against	system	failures,
including	but	not	limited	to	back-up	or	shut	down	mechanisms.
Because	each	end-user	system	is	customized	and	differs	from
National	Instruments'	testing	platforms	and	because	a	user	or
application	designer	may	use	National	Instruments	products	in
combination	with	other	products	in	a	manner	not	evaluated	or
contemplated	by	National	Instruments,	the	user	or	application
designer	is	ultimately	responsible	for	verifying	and	validating	the
suitability	of	National	Instruments	products	whenever	National
Instruments	products	are	incorporated	in	a	system	or	application,
including,	without	limitation,	the	appropriate	design,	process	and
safety	level	of	such	system	or	application.



Technical	Support	and	Professional	Services
Visit	the	following	sections	of	the	National	Instruments	Web	site	at	ni.com
for	technical	support	and	professional	services:

Support—Online	technical	support	resources	at	ni.com/support
include	the	following:

Self-Help	Resources—For	answers	and	solutions,	visit	the
award-winning	National	Instruments	Web	site	for	software
drivers	and	updates,	a	searchable	KnowledgeBase,	product
manuals,	step-by-step	troubleshooting	wizards,	thousands	of
example	programs,	tutorials,	application	notes,	instrument
drivers,	and	so	on.
Free	Technical	Support—All	registered	users	receive	free
Basic	Service,	which	includes	access	to	hundreds	of
Applications	Engineers	worldwide	in	the	NI	Developer
Exchange	at	ni.com/exchange.	National	Instruments
Applications	Engineers	make	sure	every	question	receives
an	answer.
For	information	about	other	technical	support	options	in	your
area,	visit	ni.com/services	or	contact	your	local	office	at
ni.com/contact.

Training	and	Certification—Visit	ni.com/training	for	self-paced
training,	eLearning	virtual	classrooms,	interactive	CDs,	and
Certification	program	information.	You	also	can	register	for
instructor-led,	hands-on	courses	at	locations	around	the	world.
System	Integration—If	you	have	time	constraints,	limited	in-house
technical	resources,	or	other	project	challenges,	National
Instruments	Alliance	Partner	members	can	help.	To	learn	more,
call	your	local	NI	office	or	visit	ni.com/alliance.

If	you	searched	ni.com	and	could	not	find	the	answers	you	need,	contact
your	local	office	or	NI	corporate	headquarters.	You	also	can	visit	the
Worldwide	Offices	section	of	ni.com/niglobal	to	access	the	branch	office
Web	sites,	which	provide	up-to-date	contact	information,	support	phone
numbers,	email	addresses,	and	current	events.
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Branch	Offices
Office Telephone	Number
Australia 1800	300	800

Austria 43	0	662	45	79	90	0

Belgium 32	0	2	757	00	20

Brazil 55	11	3262	3599

Canada 800	433	3488

China 86	21	6555	7838

Czech	Republic 420	224	235	774

Denmark 45	45	76	26	00

Finland 385	0	9	725	725	11

France 33	0	1	48	14	24	24

Germany 49	0	89	741	31	30

India 91	80	51190000

Israel 972	0	3	6393737

Italy 39	02	413091

Japan 81	3	5472	2970

Korea 82	02	3451	3400

Lebanon 961	0	1	33	28	28

Malaysia 1800	887710

Mexico 01	800	010	0793

Netherlands 31	0	348	433	466

New	Zealand 0800	553	322

Norway 47	0	66	90	76	60

Poland 48	22	3390150

Portugal 351	210	311	210

Russia 7	095	783	68	51

Singapore 1800	226	5886

Slovenia 386	3	425	4200

South	Africa 27	0	11	805	8197

Spain 34	91	640	0085

Sweden 46	0	8	587	895	00

Switzerland 41	56	200	51	51

Taiwan 886	02	2377	2222

Thailand 662	278	6777

United	Kingdom 44	0	1635	523545

United	States	(Corporate) 512	683	0100
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